Welcome to NX 12

October 2017

Dear Customer:

We are proud to introduce the latest release of our product development solution, NX 12. With this release, we continue to provide innovative ways to deliver solutions that meet the next generation of your product design, development, and manufacturing challenges. NX 12 is robust and powerful, and it delivers advanced technologies for product design, development, and manufacturing in a single, multidisciplinary platform. It preserves best-in-class customer deployment readiness, and builds on the productivity and stability achievements of the previous release. We’ve summarized the key improvements below:

Design
NX 12 removes barriers to innovation and empowers engineers to quickly achieve optimal design solutions by utilizing their full creative potential. NX 12 includes hundreds of end-user enhancements that will increase your productivity. One example is the simultaneous display of multiple windows, which greatly improves concurrent working methods. Building on major enhancements introduced in NX 11, such as Convergent Modeling™, NX 12 delivers refined tools that support the generative design workflow by allowing direct manipulation of scanned or optimized facet geometry. In addition, our close integration with Mentor Graphics Capital facilitates the intelligent integration of electronic and electrical design with mechanical design. To support the increasing adoption of additive manufacturing, this release combines advanced tools with traditional modeling methods for designing lightweight parts, reinforcing the new capabilities with custom design validation checkers that ensure manufacturability. Together, these enhancements and functionality bolster NX’s standing as the design tool of choice.

Simulation
Simcenter 3D is a unified, scalable, open, and extensible environment for 3D simulation that is based on the NX platform. This release of Simcenter 3D revolutionizes how simulation engineers can help drive design direction and predict product performance. It provides new solutions, such as topology optimization powered by NX Nastran, and supports seamless integration with NX Convergent Modeling™—allowing designers and advanced analysts to quickly generate and explore new design concepts. This release expands and integrates an impressive array of new technologies that build on LMS technologies for acoustics, structural, and motion analyses, and it broadens support for nonlinear solutions to include multi-step and dynamic nonlinear solutions. With new capabilities in motion, thermal, flow, and pre/post, as well as enhancements in discipline-specific modeling and post-processing, Simcenter 3D empowers engineers to be more productive while enabling more realistic and efficient CAE workflows than ever before.
Manufacturing

NX CAM 12 brings powerful technologies that enable a new level of production efficiency on the shop floor. Adaptive milling, a new high-speed roughing method, significantly reduces machining time while extending cutting tool life. Using the new 5-axis tube milling, NC programmers rely on built-in expertise to efficiently rough and finish narrow hollow features, including ports on engine blocks and shrouded blisks. For high-volume production of complicated parts with many features, the new NX Machining Line Planner, combined with integrated NX CAM, enables distribution, balancing, programming, and simulation of operations over multiple setups and machines. This release also brings new and robust additive manufacturing capabilities to drive a wide range of 3D printer types, including HP Multi Jet Fusion printers. Along with functionality to more easily create complex support geometries, and capabilities for automated 3D nesting, NX truly facilitates the application of additive manufacturing for industrial production.

For more information about these and other enhancements, see the What's New Guide included with the NX 12 help.

We are confident that NX 12 transforms the way products come to life, and we hope it empowers you to achieve your next generation of innovation.

Sincerely,

Your NX 12 Team
## Contents

Welcome to NX 12 .................................................. 2

**System Information** ............................................. 1-1
Customer support .................................................. 1-2
Platforms .......................................................... 1-2
  - NX central runtime directory ................................ 1-2
  - System requirements guidelines .............................. 1-4
  - Operating system requirements .............................. 1-7
Mac OS X Support ................................................. 1-10
Supported hardware and graphics .............................. 1-14
NX Open programs on Linux .................................... 1-15
Linux graphics caveats .......................................... 1-16
Initializing the JVM ............................................. 1-17
NX variables in the ugli_env.dat file ......................... 1-18
Browser requirements .......................................... 1-20
  - Browser and plug-in requirements .......................... 1-20
  - Browser caveats .............................................. 1-22
Licensing Caveats ................................................ 1-23
  - General licensing caveats .................................. 1-23
  - Licensing caveats for Windows ............................... 1-24
  - Licensing caveats for Linux ................................ 1-25
  - Licensing caveats for Mac OS X ............................. 1-26
Product compatibility - supported version combinations 1-28
NX compatibility with Spreadsheet ............................ 1-30
NX applications unsupported on specific platforms ........ 1-32
Support for touch enabled devices ......................... 1-33

**Teamcenter Integration for NX** ............................... 2-1
Product Notes .................................................... 2-2
Caveats .......................................................... 2-3

**Fundamentals** .................................................. 3-1
Product Notes .................................................... 3-2
Caveats .......................................................... 3-3

**Customer Defaults** ............................................ 4-1
Customer defaults ............................................. 4-2

**Design (CAD)** ................................................. 5-1
Modeling ......................................................... 5-1
  - Product Notes .............................................. 5-1
<table>
<thead>
<tr>
<th>Documentation Notes</th>
<th>5-2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drafting</td>
<td>5-2</td>
</tr>
<tr>
<td>Product Notes</td>
<td>5-2</td>
</tr>
<tr>
<td>Documentation Notes</td>
<td>5-6</td>
</tr>
<tr>
<td>Caveats</td>
<td>5-7</td>
</tr>
<tr>
<td>Layout</td>
<td>5-7</td>
</tr>
<tr>
<td>Product Notes</td>
<td>5-7</td>
</tr>
<tr>
<td>Product and Manufacturing Information (PMI)</td>
<td>5-7</td>
</tr>
<tr>
<td>Product Notes</td>
<td>5-7</td>
</tr>
<tr>
<td>Documentation Notes</td>
<td>5-11</td>
</tr>
<tr>
<td>Routing</td>
<td>5-11</td>
</tr>
<tr>
<td>Caveats</td>
<td>5-11</td>
</tr>
<tr>
<td>Documentation Notes</td>
<td>5-13</td>
</tr>
<tr>
<td>Product Notes</td>
<td>5-14</td>
</tr>
<tr>
<td>Ship Structure</td>
<td>5-17</td>
</tr>
<tr>
<td>Caveats</td>
<td>5-17</td>
</tr>
<tr>
<td>Sheet Metal</td>
<td>5-17</td>
</tr>
<tr>
<td>Caveats</td>
<td>5-17</td>
</tr>
<tr>
<td>PCB Exchange</td>
<td>5-18</td>
</tr>
<tr>
<td>Caveats</td>
<td>5-18</td>
</tr>
<tr>
<td>4th Generation Design</td>
<td>5-18</td>
</tr>
<tr>
<td>Caveats</td>
<td>5-18</td>
</tr>
</tbody>
</table>

**Manufacturing (CAM)** .......................................................... **6-1**

Manufacturing Product Notes .................................................. 6-1
<table>
<thead>
<tr>
<th>Manufacturing Product Notes</th>
<th>6-1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manufacturing Product Notes</td>
<td>6-1</td>
</tr>
<tr>
<td>CAM Early Access program</td>
<td>6-2</td>
</tr>
<tr>
<td>Tool path and template changes</td>
<td>6-3</td>
</tr>
<tr>
<td>General changes</td>
<td>6-4</td>
</tr>
<tr>
<td>Integrated Simulation and Verification (ISV)</td>
<td>6-5</td>
</tr>
<tr>
<td>Turning</td>
<td>6-9</td>
</tr>
<tr>
<td>Hole machining</td>
<td>6-10</td>
</tr>
<tr>
<td>Feature-based Machining (FBM)</td>
<td>6-11</td>
</tr>
<tr>
<td>Manufacturing critical maintenance and retirement notices</td>
<td>6-12</td>
</tr>
<tr>
<td>Manufacturing caveats</td>
<td>6-14</td>
</tr>
<tr>
<td>General caveats</td>
<td>6-14</td>
</tr>
<tr>
<td>Milling caveats</td>
<td>6-16</td>
</tr>
<tr>
<td>Hole machining caveats</td>
<td>6-19</td>
</tr>
<tr>
<td>ISV caveats</td>
<td>6-20</td>
</tr>
<tr>
<td>Post Configurator</td>
<td>6-22</td>
</tr>
<tr>
<td>Feature based machining caveats</td>
<td>6-23</td>
</tr>
<tr>
<td>Line Designer</td>
<td>6-23</td>
</tr>
<tr>
<td>Product notes</td>
<td>6-23</td>
</tr>
<tr>
<td>Documentation notes</td>
<td>6-26</td>
</tr>
<tr>
<td>Caveats</td>
<td>6-27</td>
</tr>
<tr>
<td>CMM Inspection Programming</td>
<td>6-27</td>
</tr>
<tr>
<td>CMM release notes</td>
<td>6-27</td>
</tr>
<tr>
<td>Caveats</td>
<td>6-29</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Simcenter (CAE)</td>
<td>7-1</td>
</tr>
<tr>
<td>Simcenter supported platforms</td>
<td>7-2</td>
</tr>
<tr>
<td>Pre/Post</td>
<td>7-2</td>
</tr>
<tr>
<td>Caveats</td>
<td>7-2</td>
</tr>
<tr>
<td>Documentation notes</td>
<td>7-10</td>
</tr>
<tr>
<td>Motion</td>
<td>7-10</td>
</tr>
<tr>
<td>Caveats</td>
<td>7-10</td>
</tr>
<tr>
<td>Documentation notes</td>
<td>7-12</td>
</tr>
<tr>
<td>Validation</td>
<td>8-1</td>
</tr>
<tr>
<td>Check-Mate and Requirements Validation</td>
<td>8-1</td>
</tr>
<tr>
<td>Caveats</td>
<td>8-1</td>
</tr>
<tr>
<td>Tooling Design</td>
<td>9-1</td>
</tr>
<tr>
<td>Press Die Checker</td>
<td>9-1</td>
</tr>
<tr>
<td>Product Notes</td>
<td>9-1</td>
</tr>
<tr>
<td>Weld Assistant</td>
<td>9-1</td>
</tr>
<tr>
<td>Documentation notes</td>
<td>9-1</td>
</tr>
<tr>
<td>Data translation</td>
<td>10-1</td>
</tr>
<tr>
<td>Product Notes</td>
<td>10-2</td>
</tr>
<tr>
<td>Caveats</td>
<td>10-3</td>
</tr>
<tr>
<td>Mechatronics Concept Designer</td>
<td>11-1</td>
</tr>
<tr>
<td>Product Notes</td>
<td>11-2</td>
</tr>
<tr>
<td>Programming Tools</td>
<td>12-1</td>
</tr>
</tbody>
</table>
Chapter 1: System Information
Customer support

Customers covered by valid maintenance agreements are eligible to receive telephone and web support from the Global Technical Access Center (GTAC) on issues regarding any current or past release. If you are a customer of one of our partners or resellers, you should contact them first to determine who is your first line support provider. If your first line of support is provided by one of our partners, they will contact us on your behalf if needed to respond to your issue.

To report serious problems against supported releases, please contact your local GTAC support center. You can find your local support center, contact phone numbers and additional information on GTAC support and available services by visiting our GTAC page at http://www.siemens.com/gtac

We will always assist our customers to the best of our ability.

Platforms

NX central runtime directory

Central runtime directory concept

Starting in NX 11, to help you find executables and libraries, and distinguish them from configuration files more easily, a central runtime directory that contains DLLs, executables, and JAR files is used. The central runtime directory will be updated as NX supports more and different applications.

Scripts that are used to wrap executables have not been moved and they are still in their original kit locations with the configuration files.

NXBIN directory

The central runtime directory, NXBIN, is created on all platforms at the UGII_BASE_DIR\nxbin location during the NX installation. Depending on what was selected to be installed, libraries and executables from different kits are consolidated into the central runtime directory during the install process.

The new NX runtime directory does not contain all binaries and executables. Only the most frequently used files from the following directories have been moved:

- UGII
- UGMANAGER
- STEP203UG
- STEP214UG
- PVTRANS
- MACH

Other files will also be moved over time. However, some applications, such as NX Nastran, will not be moved.
While NXBIN does not contain all of the executables and DLL’s, it does contain a large quantity and is a prime location to search for an executable or library.

**UGII_ROOT_DIR obsoleted**

UGII_ROOT_DIR has historically been used to find the following in the UGII directory:

- Libraries and executables
- Configuration files

With the creation of the central runtime directory, there are two different locations for these files (*nxbin* and *ugii*), so the concept of UGII_ROOT_DIR is obsoleted. Use the UGII_BASE_DIR variable instead when you write custom application code and scripts.

While the NX install no longer sets UGII_ROOT_DIR, the definition on the system will remain to support earlier releases. If your code or scripts rely on UGII_ROOT_DIR, modify them to ensure they work in NX 12.

**Teamcenter code and scripts**

To provide backward compatibility with released versions of Teamcenter, all executables called directly by Teamcenter code or scripts are wrapped.

The wrapper executables just correct the settings of the UGII_BASE_DIR, PATH, and LD_LIBRARY_PATH variables that are set by the Teamcenter scripts and code, and then start up the real executable from the NXBIN directory. This enables support for the new runtime concept, while allowing NX to run with existing versions of Teamcenter.

These new wrapper executables must remain in the *ugii* and *ugmanager* directories since that is where Teamcenter code expects to find them. Two processes are shown for executables invoked from the *ugii* and *ugmanager* directories.

Executables are still in the UGII, UGMANAGER, STEP203UG, STEP214UG, and PVTRANS kits.

Teamcenter code migration to the new central runtime directory structure is scheduled in a future Teamcenter release.
System requirements guidelines

Defining the minimum system requirements is difficult because key requirements, most notably memory, can vary dramatically from user to user. The following are general guidelines that you should consider before purchasing a system.

Processor performance

Although raw processor speed has a major impact on system performance, other factors also contribute to overall performance; for example, the type of disk drive (SCSI, ATA, or Serial ATA), disk speed, memory speed, graphics adapter, and bus speeds. The general rule is that "the faster the processor, the better the performance is," but this only applies when comparing like architectures. For example, it is difficult to arrive at performance expectations for an Intel processor when compared to an AMD processor just by looking at their respective processor speeds. There is also a general trend today to de-emphasize processor speeds and move to multi-core processors, which actually can have lower processor speeds.

NX takes advantage of modern processors, and if a processor does not have the required functionality, you will see the following error message and NX will not run on the installed CPU:

This processor is too old and not supported anymore

SMP

Symmetric Multiprocessing (SMP) is supported in NX mostly via Parasolid, although a small number of NX capabilities have some threading. In general, it is not possible to quote a figure for the general performance improvement achieved by using SMP, since this improvement depends on the nature of the operations you are performing. You need to evaluate your actual performance gains using your own models. Functional areas that are SMP enabled in Parasolid include:

- Validity checking
- Boolean operations
- Wireframe
- Rendering
- Hidden line rendering
- Closest approach
- Faceting
- Mass properties

SMP is enabled by default with the variable UGII_SMP_ENABLE, which is located in the ugii_env_ug.dat file.

Multi-Core

Multi-core processors are similar to SMP because there are two or more actual processor cores but they are delivered in single processor packages. Siemens PLM Software has found that multi-core performance characteristics are similar to SMP. The one advantage of multi-core processors
over SMP is that this technology has proliferated much faster than SMP and is now common in
workstations, servers, and laptops.

Multi-core technology is complex and, depending on the configuration, can actually have a negative
impact on performance. This is due to the potential conflict of multiple cores sharing system
resources, such as cache, memory, and bus bandwidth, as well the need for the system to manage
and control an increasing number of cores. Increasing the number of cores does not always translate
into better performance. Although additional cores can improve NX performance, processor speed is
still a vital measurement of NX performance.

Many systems enable you to turn off cores via the bios, which can enable you to compare
performance with a different number of cores that are active. Some users may find that turning
off some cores will actually improve performance. One micro-architecture (Intel) even does this
automatically, shutting down unused cores and increasing the clock speed of the others.

The hardware vendors continue to improve their processor micro-architectures to better address the
limitations of older multi-core technologies. New subsystems better integrate memory and other
peripherals directly to the processors, resulting in major performance improvements. Buses are being
eliminated, cores are better managed, and channel speeds continue to improve.

In summary:
• Turn SMP on only if you have an SMP system. Having it on in a single-processor system incurs a
  slight overhead.
• Turn SMP on if you have a multi-core system.
• Never assume that by simply adding more cores you will see better performance. Always test first.

Memory

The minimum recommended amount of memory to run native NX is 8GB. If you are running NX
with Teamcenter (Teamcenter Integration for NX), the minimum recommended is 12 GB. However,
because NX is capable of handling large assemblies and very complex parts, many of our customers
use workstations with 32GB of RAM, and some even use 64GB, 96GB, or more.

For the optimum user experience and application performance, we recommend that you install as
much RAM as can be installed in the client workstation that is running NX.

As a guideline, so that you get the best possible performance when using NX, ensure that the
amount of physical memory (RAM) in your workstations is always larger than the amount of memory
consumed by NX, plus all the other applications that are running at the same time on the same
machine. This can be done by using a tool such as Windows Task Manager or Resource Monitor.

The minimum memory requirements varies and depends on various factors including:

• Complexity of the geometry within individual parts

• Size of the assemblies that are loaded
  o Less memory is required if the assemblies contain multiple instances of the same
    components.
  o More memory is required when large assemblies contain lots of unique components with
    complex geometry.
• Use of Teamcenter in addition to NX
  o Some additional memory is required when using Teamcenter 4-tier.
  o A even greater amount of memory is required when using Teamcenter 2-tier.
• Fully loading exact assemblies versus using lightweight assemblies and partial loading
• Generating CAM toolpaths for very complex geometry, such as an automotive engine block or gearbox
• Updating large assembly drawings

Graphics adapters

All the NX certified systems contain graphics adapters that meet all Siemens PLM Software requirements and are fully supported by our hardware partners. The graphics adapters supported are carefully selected by working with our OEM partners as well as our graphics vendor partners. We do not recommend low-end, consumer, or game cards, since these graphics devices are developed for the DirectX market and are not well supported under OpenGL. Because a majority of platform/hardware problems are graphics related, it is critical that all the graphics adapters that NX supports are designed for OpenGL and have the highest level of support from our hardware vendors. We highly recommend that you only use supported graphics adapters and Siemens PLM Software certified drivers.

If you are running Microsoft Windows 7 you will require graphics adapters with more on-board memory, especially when AERO (the enhanced 3D feature) is turned on. The minimum recommended graphics on-board memory is 256 MB, and although graphics adapters with less memory will work, the performance may not be adequate, even with AERO turned off. If you have high-end graphics requirements, you will need to consider graphics adapters with 512 MB or higher on-board memory.

For the latest information on certified graphics cards and driver versions, please visit the Customer Support (GTAC) Web site.

Multiple monitors

Siemens PLM Software supports multi-monitors but with limitations. These limitations were necessary due to the large number of possible configurations. Other combinations may work, but these conditions are tested and supported by Siemens PLM Software. These guidelines could be extended or relaxed in the future.

The following is a summary of findings for the support of multiple monitors.
• NX 6.0.1 or higher - no older releases are supported.
• Two monitors only.
• LCD monitors only
• Run with native resolution and aspect ratio.
• Laptops are tested without docking stations or port replicators (direct connection only).
• Horizontal Scan mode (not Vertical) and only with identical monitors.
• Dual View (Nvidia) or Extended View (ATI) modes, but the user must have the display window entirely in either the primary or secondary monitor.

You do not have to comply with the configurations mentioned above, but Siemens must be able to duplicate the problem on the configurations in our labs before being able to investigate your issues.

**Operating system requirements**

**Operating system requirements**

This section documents operating system and service pack requirements.

**Minimum Operating Systems**

The following operating systems are the minimum recommended for NX 12. Newer versions and service packs are available as they are released.

<table>
<thead>
<tr>
<th>O.S.</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Windows (64-bit)</td>
<td>Microsoft Windows 10 Pro and Enterprise editions</td>
</tr>
<tr>
<td>Linux (64-bit)</td>
<td>SuSE Linux Enterprise Server/Desktop 12</td>
</tr>
<tr>
<td>Mac OS X</td>
<td>Red Hat Enterprise Linux Server/Desktop 7</td>
</tr>
<tr>
<td></td>
<td>Version 10.12.2</td>
</tr>
</tbody>
</table>

**Note**

Simcenter does not support the Mac OS X.

**Windows 10**

Windows 10 is the minimum supported release for NX 12. The supported versions of Windows 10 are the Professional and Enterprise editions utilizing either the Current Branch for Business (CBB) or Long Term Service Branch (LTSB) update branch. The Current Branch (CB) update option is not supported.

Windows 10 is also available for NX 10.0.3 and later versions including NX 12. Any caveats or special instructions are provided in the SFB announcing support.

**Windows 7 and 8.1**

Windows 7 has reached the end of life and mainstream support has ended. Windows 8.1 is still supported by Microsoft, but was rarely deployed. These two versions of Windows are no longer supported by NX 12. Siemens PLM Software has not performed testing on these versions and cannot resolve any issues related to NX 12 running on these operating systems. If NX 12 is deployed on these versions of Windows, any issues will have to be replicated on Windows 10 before filing an incident report with GTAC.

**Windows XP and Vista**

Windows XP support from Microsoft has ended and Vista was rarely deployed so these two versions of Windows are not supported by NX 12. Siemens PLM Software has not performed testing on these versions and cannot resolve any issues related to NX 12 running on these operating systems. If NX
12 is deployed on these versions of Windows, any issues will have to be replicated on Windows 10 before filing an incident report with GTAC.

**System error when running NX**

If you receive the following system error when launching NX, the problem is generally that the operating system is not up-to-date for the required and optional updates. This error can occur with Windows 7 and Windows 8.1.

The program can't start because api-ms-win-crt-heap-l1-1-0.dll is missing from your computer.

The error occurs when there are missing Visual C++ libraries due to a dependency on the Universal CRT libraries in Visual C++ 2015. To fix the problem, install the **Visual C++ 2015 update 3 redistributable** from Microsoft. The redistributables for both the 32-bit (vc_redist.x86.exe) and 64-bit (vc_redist.x64.exe) are available in the INSTALL folder of the NX runtime environment after installation, or you can download the redistributable from Microsoft.

If you still have a problem, contact GTAC support.

**Linux Distributions**

NX is developed using Linux standards and accepted Linux development conventions. Quality assurance testing is performed on the two versions of Linux listed in the table above. Siemens PLM Software cannot guarantee operation, performance, compatibility, or support on any other distributions.

The following is a list of information about the NX 12 development environment (for reference only):

<table>
<thead>
<tr>
<th>Component</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Kernel</td>
<td>kernel3.10.0-123el7.x86_64</td>
</tr>
<tr>
<td>X Windows</td>
<td>libX11-devel-1.6.0-2.1</td>
</tr>
<tr>
<td>Motif</td>
<td>motif-devel-2.3.4-7</td>
</tr>
<tr>
<td>Open GL</td>
<td>mesa-libGL-devel-9.2.5-5.20131218</td>
</tr>
<tr>
<td>C, C++ Compiler</td>
<td>gcc 4.8.2</td>
</tr>
<tr>
<td>Java Development version</td>
<td>1.8.0</td>
</tr>
</tbody>
</table>

**Considerations and caveats**

**Linux Requirements**

NX supports SuSE Linux and Red Hat Linux, both 64-bit only. The minimum supported version of SuSE Enterprise (Desktop/Server) is 12 and Red Hat Enterprise (Desktop/Server) is 7.0. Newer versions will be supported via certification.

**Note**

Ensure that X11 and the Motif libraries are installed.

Visit the Customer Support (GTAC) Web site for details of supported hardware configurations as well as for the latest graphics drivers.
Java Runtime Environment

Starting in NX 8.5, the Java Runtime Environment (JRE) is no longer shipped with NX. NX requires JRE 8. To install the JRE, visit the Java download site at http://java.com/en/download/index.jsp

Java is used for the following products:

- NX Relations Browser
- Product Template Studio
- Manufacturing – Process Studio Author
- Command line version of the following translators:
  - CATIA V4
  - CATIA V5
  - Dxfdwg
  - IGES
  - NX Pro E
  - Step AP203
  - Step AP214
- Knowledge Fusion ICE
- Online Help

**Note**

NX 9.x and earlier versions contain a different Help Search that requires the latest version of the Java plugin installed as an Add On to the browser. NX 10 and later versions do not require the Java plugin for the Help Search.

- Quality Dashboard
- Validation Rule Editor
- Batch Mesher
- Customer written NX Open Java programs
- NX Response Simulation Function Tools

**Java requirements for NX Open**

NX Open for Java is designed to be used with Java version 1.8.0 or higher.
Post Processing of Abaqus ODB format results

In the NX 12 release, NX uses Abaqus version 6.12 libraries to process ODB results files. For NX to use these libraries, you must first install Visual C++ 2008 X64 Runtime – v9.0.30729.4967.

**Note**

If you have Abaqus version 6.12 installed on your system, the required Visual C++ runtime should already be installed.

You can download this runtime from the Simulia customer support website: [http://www.3ds.com/products-services/simulia/support/](http://www.3ds.com/products-services/simulia/support/)

For more information on the system requirements for ODB version 6.12 files, see: [http://www.3ds.com/support/certified-hardware/simulia-system-information/abaqus-612/system-requirements-for-abaqus-612-products](http://www.3ds.com/support/certified-hardware/simulia-system-information/abaqus-612/system-requirements-for-abaqus-612-products)

Running Samcef in parallel

On Windows, when you run parallel computations with the built-in Samcef solver, Python 2.7 is required. In NX 12, that version of Python is not present. Install Python 2.7 on your disk and ensure that the Python directory is named **Python27** (default name) and is included on your PATH variable.

You can download the software from the Python website: [https://www.python.org/downloads/](https://www.python.org/downloads/)

**Note**

The Python requirement does not apply if you have Samcef installed separately from NX.

Configuration files

Starting with NX 12, the NX configuration files on Windows are written to 
C:\users\<name>\AppData\Local\Siemens.

Installing the .NET Framework

The NXOpen for .NET API is a Windows-specific project that leverages the Microsoft .NET Framework component. Before you can execute a custom .NET application, you must install the .NET Framework 4.6. In addition, to replay a .NET journal, the .NET Framework 4.6 must be installed.


Mac OS X Support

Hardware and installation requirements

Hardware and operating system requirements

The release of NX 12 on Mac OS X supports Apple Mac 64-bit Intel based systems. These include the MacBook Pro, iMac and Mac Pro systems. All available graphics subsystems are supported.
The minimum version of Mac OS X required to run NX 12 is version 10.12.2. Later versions of Mac OS X are also supported, but there may be caveats.

Installation of NX on Mac OS X is supported only on an HFS+ file system. However, NX part files and other data files may be stored and retrieved from an NFS file system.

**X11 requirements**

NX 12 on Mac OS X utilizes X11 to support its graphical user interface. Xquartz 2.7.8 is required on OS X 10.12 "Sierra." You will be prompted to install Xquartz when attempting to run any X11 application for the first time and guided through the installation by those prompts. Check for Xquartz updates from the X11→Check for X11 Updates.... dialog box.

You can download Xquartz at [http://www.xquartz.org/](http://www.xquartz.org/)

The X11 application must be running while using NX. The X11 application is started when NX or any other X-based application is invoked.

**Installation**

Installation must be performed from an account with administrator privileges. To install, double-click on the ug_install script.

**Product notes**

**Mouse focus policies**

The X11 mouse focus policy specifies how the mouse advises X11 on which window is active and can receive keystrokes. The **Click-through Inactive Windows** and **Focus Follows Mouse** operations are often preferred to the X11 defaults.

In the X11 bundled with Lion, the mouse focus policies are set by choosing X11→Preferences, Windows tab. The Windows tab contains the following options:

- **Click-through Inactive Windows**
- **Focus Follows Mouse**
- **Focus On New Windows**

You must restart X11 for a change to take effect. Note that the setting applies only to the user's own preferences, not to the system wide preferences. Refer to the quartz-wm man page for details.

**Pasteboard/Clipboard Setup**

The X11 Pasteboard policy defines how the Mac OS Pasteboard communicates with the X11 CLIPBOARD. To ensure proper clipboard copy/paste behavior in NX, syncing between the Mac OS Pasteboard and X11 CLIPBOARD should be disabled.

In the X11 bundled with Lion, the Pasteboard policies are set by choosing X11→Preferences, Pasteboard tab. Uncheck the **Enable syncing** option.

Note that the setting applies only to the user’s own preferences, not to the system wide preferences. Refer to the quartz-wm man page for details.
3D Input Devices

Support for 3Dconnexion input devices is available for NX on Mac OS X through the use of drivers and software available directly from 3Dconnexion. Use the following link to download the software and get installation information.

http://www.3dconnexion.com/service/drivers.html

Plotting

MAC OS X printing systems handle PDF files in native mode. NX Plotting takes advantage of this by creating a PDF file which it hands off to a Macintosh application that handles the printing task. Because these native tools can interface with the printing system, the usual SDI plotting software used with other platforms is not used on MAC OS X.

Teamcenter Integration support for Mac OS X

Teamcenter Integration (TCIN) is supported on the Mac platform when you run in a four-tier environment. The operation and functionality of Teamcenter Integration on the Mac platform is the same as on other platforms.

Note

The Teamcenter two-tier environment is not supported.

The Mac client setup in a four-tier Teamcenter environment is similar to the setup for Linux. However, you have to install the Mac client as a TCCS installation instead of an FMS installation. Typically, the TCCS install is done as part of the RAC TC install, but since the Teamcenter RAC install does not support the Mac platform, the TCCS standalone installer needs to be used. This installer is provided on the Teamcenter Mac DVD or Mac install download. For install and setup information, see the Teamcenter installation documentation.

After installation is complete, you can create a script to setup TCIN for use before launching NX. The following is a sample script:

Note

- The values and paths used here are for example only. Use the values and paths that are applicable for your site.

- The line:

  defaults write com.siemens.plm.nx12 PIM Yes

  sets the -pim option to Yes. You can set this back to No to run native NX.

- You do not set the user name (-u) and password (-p) options in the script. You enter these in the dialog box that is displayed when you run NX.

Sample script:

  defaults write com.siemens.plm.nx12 FMS_HOME /home/UGS/Teamcenter/Tc12/tccs
defaults write com.siemens.plm.nx12 UGII_UGMGR_HTTP_URL http://annpc38:7001/tc/aiws/aiws
defaults write com.siemens.plm.nx12 PIM Yes
defaults write com.siemens.plm.nx12 JAVA_HOME /System/JavaVM.framework/Versions/1.5/Home
defaults read com.siemens.plm.nx12 FMS_HOME=/home/UGS/Teamcenter/Tc12/tccs; export FMS_HOME
JAVA_HOME=/System/Library/Frameworks/JavaVM.framework/Versions/Current/Commands/java_home; export JAVA_HOME

Caveats

Mac OS X 10.12

If you are using Mac OS X version 10.12 (Sierra), the minimum supported version for NX 12 is version 10.12.2. Apple’s release of Sierra (Mac OS X 10.12) does not include the X11 libraries required by NX. Xquartz 2.7.8 is required. You will be prompted to install Xquartz when attempting to run any X11 application for the first time and guided through the installation by those prompts. Check for Xquartz updates from the X11→Check for X11 Updates.... dialog box.

CAE

NX 12 on Mac OS X does not support any Simcenter (CAE) functionality. Simcenter modules and specialized NX functions that depend on Simcenter are not supported.

Plotting

Plotting of high quality images using the View→Visualization→High Quality Image command does not work.

Relations Browser

The relations browser is not supported. When you choose Assemblies→WAVE→Relations Browser, the command does not work.

Spreadsheet support

NX 12 on Mac OS X does not support the use of any spreadsheet.

Enabling the Alt key

When you use NX, the Alt key can be very handy. The Mac OS does not automatically enable the Alt key for use with NX. You have to update the X server’s keyboard mapping.

Redefine the key on the keyboard

To enable the Alt key, you need to update the keyboard mapping to redefine the key labeled alt/option. Enter the following command in a Terminal window:

```
defaults write org.x.X12 option_sends_alt -boolean true
```

The alt/option key now sends Alt_L and Alt_R instead of Mode_switch.
Supported hardware and graphics

The list of currently supported hardware and graphics cards can be found on the GTAC support page Customer Support (GTAC) Web site at Hardware and Software Certification→Hardware (Graphics Card) Certifications. This opens a spreadsheet that has tabs for supported systems and graphics.
NX Open programs on Linux

If you try to link an external NX Open C++ program using the `ufmenu` and `uflink` scripts with NX 12 on SLES 12, Linux may fail with an error message such as:

```
/usr/x86_64-suse-linux/bin/ld: cannot find -lelf
/usr/x86_64-suse-linux/bin/ld: cannot find -lXm
```

For NX to properly build an NX Open program, you must have the correct RPM kits installed.

For NX 12 and SUSE 12, the following packages are required:

```
libXm4-2.3.4-4.15.x86_64.rpm
motif-devel-2.3.4-4.15.x86_64.rpm
elfutils-0.158-3.200.x86_64.rpm
libelf1-0.158-3.200.x86_64.rpm
libelf-devel-0.158-3.200.x86_64.rpm
```

For NX 12 and RedHat 7, the following packages are required:

```
motif-2.3.4-7.el7.x86_64.rpm
motif-devel-2.3.4-7.el7.x86_64.rpm
elfutils-libelf-0.158-3.el7.x86_64.rpm
elfutils-libelf-devel-0.158-3.el7.x86_64.rpm
elfutils-devel-0.158-3.el7.x86_64.rpm
elfutils-libelf-0.158-3.el7.x86_64.rpm
elfutils-libs-0.158-3.el7.x86_64.rpm
```

**Note**

For SUSE, the `devel` packages are available from the optional SLE 12 SDK DVD/ISO.
Linux graphics caveats

Some applications experience a severe X server crash with Red Hat 7 (and later) and SuSE 12. The crash of the server causes the user to exit the login session. When this occurs, the user must login again. This problem has only been seen on nVidia graphics boards. If you are using an older driver, the first recommendation is to try the latest graphics driver. If this problem is observed in other applications, the following workaround can be applied.

Note

Use this workaround only if you experience the problem, as it can cause a performance slowdown. To work around this problem, modify `/etc/X12/xorg.conf` and add the following line to the `Device` section for nVidia after the `Driver` line.

```plaintext
Option "UseCompositeWrapper" "true"
```

Thus, after the change, the device entry in `xorg.conf` might look like:

```plaintext
Section "Device"
  Identifier   "Videocard0"
  Driver      "nvidia"
  Option      "UseCompositeWrapper" "true"
EndSection
```

You must login as `root` in order to make this change. It is prudent to make a backup copy of `/etc/X12/xorg.conf` before making this change. Each time the nVidia driver (the same or a newer version) is installed, you need to take the above steps to ensure the `Option` line is included. In order for the change to take effect, you must restart the X server by either rebooting or pressing Ctrl+Alt+Backspace (if you are in a live X session).

Note

With some AMD configurations on Red Hat and SuSE, a different problem has been observed whose similarity with the problem seen with the nVidia configuration may cause you to believe it is the same problem. This problem causes NX and many X applications to fail with a segmentation violation or a memory fault at the start. However, this problem is likely due to the AMD graphics driver not being configured correctly. The simple solution to this problem is to do the following:

1. Login as root
2. Make a backup copy of `/etc/X12/xorg.conf`.
3. Remove `/etc/X12/xorg.conf`.
4. Regenerate a new `xorg.conf` by running the command:
   ```bash
   aticonfig --initial
   ```
5. Restart the X server.
 Initializing the JVM

In some cases, NX is not able to create the Java Virtual Machine (JVM) properly on Windows. The root cause in these scenarios is insufficient memory to start the JVM. In most cases of insufficient memory Java is able to report back an error code indicating this problem. However, in some cases Java reports a generic error message that NX then displays. The typical error message is:

Can’t initialize the Java Virtual Machine (JVM)

When running a Java application, such as the Wave Browser or Interactive Class Editor, NX may give an unexpected error due to this problem.

Starting in NX 8, if NX detects that there is not enough memory available for the JVM, an error message is given and information is provided in the syslog. The following is an example of the syslog information:

The JVM could not be created due to not enough memory.
The Java heap size must be contiguous and the largest contiguous block available is outputted below.
Windows largest block free
---------------------------------
Maximum block 267Mb
---------------------------------
Please note, this number is to be used as suggestion for setting the heap size. It is unlikely that you will be able to utilize the full amount.
If you need a heap size larger than what is possible you can try to use the /3GB switch or its equivalent, if available for the Operating System you are on. Otherwise your other option is to use Remoting. Please consult the NX Open Programmer's Guide for more information on this topic.

Reset the size of the Java heap

To remedy this problem, you can reset the size of the Java heap that NX uses. Choose File→Execute→Override Java Parameters to open the dialog box and set UGII_JVM_OPTIONS to the size of the Java heap. You can experiment with the size of heap that you need, but if the JVM is already started then you cannot change the UGII_JVM_OPTIONS setting.

It is recommended that you use both the -Xmx and -Xms options together. Both of these are needed as Java may determine default values for the heap size that are not possible with the machine’s current memory load. For example:

UGII_JVM_OPTIONS=-Xmx=50M -Xms=50M

When trying to determine the size of the heap, keep in mind that if the heap size is too small, a Java program you are trying to run may not run. This could be due to the amount of memory available on the machine, or due to multiple Java processes running. This can be the case with the Wave Browser where there is a client and server process.

Once you find a value that works, you can modify the UGII_JVM_OPTIONS value in the ugii_env.dat file so you don’t have to reset it in the NX Open Java Parameters dialog box each time you start an NX session.
NX variables in the ugii_env.dat file

Standard and modified environment variables

The ugii_env_ug.dat file contains the standard environment variables for NX. You can override these variables with the ugii_env.dat file. This file is essentially empty when delivered. You can define new values for the environment variables in this file and they take precedence over the values defined in the ugii_env_ug.dat file.

The ugii_env.dat file should be used to modify any standard NX environment variables or add new ones.

Both the ugii_env_ug.dat and ugii_env.dat files are located at <UGII_BASE_DIR>\ugii.

Note
You can make all, some, or none of the changes to the variables in the ugii_env_ug.dat file. However, it is recommended that you use the ugii_env.dat file to define all of the values in use at your site.

Using the ugii_env.dat file

The following apply when using the ugii_env.dat file:

• Define the variables before the #include statement.

• The first variable defined is used. If you have the variable defined twice in the file, only the first one is used.

Note
This also applies to the ugii_env_ug.dat file.

• You cannot have spaces in the variable names.

Designate a single ugii_env.dat file for all users

You can place the ugii_env.dat file in a central location for all users to access.

For each user, set the environment variable UGII_ENV_FILE to the location of the file. For example:

UGII_ENV_FILE=G:\common\version_env_vars.corp_standards

Note
The file can have any name but must be a fully qualified path.

Statements you can use in the ugii_env.dat file

The statements that you can use in the ugii_env.dat file are shown below with examples:

• #if/#else/#endif
Used to check for specific conditions and then to define variables based on those conditions. Conditions that can be checked are:

- **FILE** - Check for the existence of a file
  
  ```
  #if FILE ${UGII_BASE_DIR}\UGII\html_files\start_${UGII_LANG}.html
  UGII_CAST_HOME=${UGII_BASE_DIR}\UGII\html_files\start_${UGII_LANG}.html
  #else
  UGII_CAST_HOME=${UGII_BASE_DIR}\UGII\html_files\start_english.html
  #endif
  ```

- **platform** - Check for a specific platform. Possible values:
  
  - x64wnt
  - lnx64
  - macosx

  ```
  #if lnx64
  UGII_CAM_THREAD_MILL=${UGII_CAM_THREAD_MILL_DIR}thrm.so
  #endif
  ```

- **$variable = “value”** - Check for a specific value for a previously defined environment variable

  ```
  #if $UGII_LANG = "simpl_chinese"
  UGII_COUNTRY=prc
  UGII_COUNTRY_TEMPLATES=${UGII_BASE_DIR}\localization\$UGII_COUNTRY\simpl_chinese
  #endif
  ```

- **$variable != “value”** - Check for a previously defined environment variable that does not have the specified value.

  ```
  #if ${UGII_PACKAGE_DIRECTORY} != ""
  if FILE ${UGII_PACKAGE_DIRECTORY}\ugii_package_env.dat
  #include ${UGII_PACKAGE_DIRECTORY}\ugii_package_env.dat
  #endif
  #endif
  ```

- Used to include a specified environment file at the current location

  ```
  #include ${UGII_PACKAGE_DIRECTORY}\ugii_package_env.dat
  ```

### Enabling context sensitive help in local languages for customer defaults and KF

When using localized language versions of the NX Help, to get context sensitive help to work for Customer Defaults or Knowledge Fusion you need to edit the following two environment variables to point to the localized help:

- **UGII_CSHELP_DEFAULTS_DOCS**
- **UGII_CSHELP_FUSION_DOCS**

For example, to enable context sensitive help for Japanese Customer Defaults help you would set:

```
UGII_CSHELP_DEFAULTS_DOCS=${UGII_UGDOC_BASE}/data_services/resources/nx/${UGII_MAJOR_VERSION}/nx_help/ja_JP/graphics/fileLibrary/nx/cust_defaults
```
Browser requirements

Browser and plug-in requirements

The NX suite of documentation (Help, What's new Guide, and Release Notes) is provided in an HTML format that is displayed in your local Web browser.

The documentation requires a web server. You can install the Siemens PLM Documentation Server, which sets up a local web server on each workstation, or install the documentation into an existing company-wide server.

The latest versions of web browsers are recommended to comply with the latest browser security updates.

Windows browser support

- Internet Explorer
- Microsoft Edge
- Mozilla Firefox
- Google Chrome

Linux browser support

- Mozilla Firefox

If you have other Mozilla web browsers installed on your system, make sure either your default browser is set to the correct Firefox version, or the UGII_HTML_BROWSER environment variable in your ugii_env.dat file is set to the supported Firefox version.

Mac OS X browser support

- Safari
- Google Chrome

Downloading browsers

These browsers are free and can be downloaded from the following Web sites:

- Internet Explorer — http://www.microsoft.com
- Firefox — http://www.mozilla.org
- Safari — http://www.apple.com
Windows .chm files

Some parts of the Help are delivered in Microsoft Compiled Help format (.chm). Windows security enhancements prohibit opening .chm Help files across a network, so you must install those files on your computer. If you install .chm Help files on a server, you cannot read the Help across the network.

Flash required for videos

To watch videos and simulations, you must have the Adobe Flash Player installed as a plug-in to your browser. You can download the Flash Player (free) at the Adobe Flash Player site.

Adobe Acrobat Reader

Some portions of the Help may be delivered as PDF, which requires the Adobe Acrobat Reader. You can download the free reader from http://get.adobe.com/reader/.
Browser caveats

Browser caveats for Internet Explorer

IE9 compatibility view. The HTML Help is fully supported when launched with the http:// protocol or the file:// protocol. However, if you are viewing an older version of the Help from a local installation, such as D://, you may need to enable the Compatibility View. In IE 9, perform the following:

2. In the Compatibility View Settings dialog box, select Display all websites in Compatibility View.

Browser caveats for Firefox

- Mozilla recommends that you upgrade to the latest version of Firefox due to security issues surrounding Java. They do not recommend using older versions of Firefox. For more information, see http://support.mozilla.org/en-US/kb/latest-firefox-issues.
- The default behavior in Firefox 3.0.5 is for new pages to be opened in a new tab. This affects the behavior of the global search since new links will open in a tab instead of a new window. You can configure Firefox to open a new window instead of a new tab by selecting Tools→Options→Tabs.
- Typically, you install and launch the Help from the http:// protocol which is fully supported. However, if you want to launch from a UNC path (file:///), Firefox has a default security setting that prevents the Help from launching correctly. To enable this, you need to change the value of the security.fileuri.strict_origin_policy preference:
  1. In the address bar, type about:config.
  2. In the Filter field, type security.fileuri. If the value of the security.fileuri.strict_origin_policy preference is set to TRUE, set the value to FALSE. Double-click on the value to toggle it.
  3. Restart the browser.
- If you are trying to open a .chm file that you have accessed from a web server (not from a local install), you may not be able to open the file as it is blocked. To unblock, right-click on the file and choose Properties, then select the unblock option.

Browser caveats for Chrome

Typically, you install and launch the Help from the http:// protocol which is fully supported. However, if you installed with the file:// protocol, you have to run Help from the command line. To fix this, see http://code.google.com/p/chromium/issues/detail?id=39767.
Licensing Caveats

General licensing caveats

License files and license server

The following are applicable to license files and the license server:

• Merging of license files is not supported.

Example

You can not merge a pre-TC 2007 MP3 or pre-NX 5 license file, which uses the uglmdb license daemon, with a TC 2007 MP3, NX 5, or NX 6 license file, which uses the ugsldm daemon.

NX 12 requires and tests for the latest version of the ugsldm vendor daemon. This vendor daemon is supplied with NX 12 and must be installed and initiated prior to starting NX 12. If an older daemon is utilized, a generic NX License Error dialog box is displayed during start-up. In addition, the syslog will contain an error message that the daemon version is older than the client.

NX Borrowing is version specific

NX license borrowing is version specific due to dependencies within the third party licensing software used by Siemens PLM Software. To ensure that NX works on a borrowed license, you should always utilize the borrow tool supplied with that NX version. For example, a license borrowed using the NX 12 borrowing tool will work for NX 12 but cannot be used to run NX 11. In addition, you cannot borrow licenses for two NX versions simultaneously on the same workstation.

Licensing Guides

Refer to the NX 12 software DVD for the most recent version of the various licensing, administration and server installation guides. The licensing guides included in the NX 12 Help are outdated and should not be used.
Licensing caveats for Windows

The following caveats are applicable to Windows platforms only.

License Option tool

The **License Option** tool should only be used to borrow NX licenses, even though it may display other licenses. The **License Option** tool does not filter features in the license file that are of an earlier version than NX 12, such as Teamcenter lifecycle visualization, so these licenses are displayed in the tool. Attempting to borrow a license other than NX 12 causes an error in the **License Option** tool.
Licensing caveats for Linux

Additional software to support licensing

SuSE and Red Hat require the following to be installed:

- LSB 4.0
Licensing caveats for Mac OS X

License server preference settings

The license server used by NX is specified during NX installation, but it may be necessary to view or change the license server setting after installation. To do that, open a Terminal window and use the following commands.

- To read the current license setting:
  ```sh
defaults read /Library/Preferences/com.siemens.plm.nx12
  
  This command will show the current setting. For example “SPLM_LICENSE_SERVER” = “28000@myserver.mycompany.com”

- To change the license setting:
  
  The following command will set the SPLM_LICENSE_SERVER preference to “myserver1”:
  ```sh
defaults write /Library/Preferences/com.siemens.plm.nx12 SPLM_LICENSE_SERVER 28000@myserver1.mycompany.com
  ```

  You may need to use “sudo” if the Preferences file is writeable only by an administrator. For example
  ```sh
  sudo defaults write /Library/Preferences/com.siemens.plm.nx12 SPLM_LICENSE_SERVER 28000@myserver1.mycompany.com
  ```

  You do not need to restart the machine after setting the NX preference.

License server naming on Mac OS X

Mac OS X is different from many other operating systems due to the fact that when the networking conditions change, the hostname of a Mac workstation will change.

For example, while on the network (<mysite>.com), the hostname is mac1.<mysite>.com. While disconnected from all networks, the hostname changes to mac1.local. FLEXnet relies on the use of the hostname to locate the server so this hostname change causes the license server daemons to lose communication and prevents the client application from connecting to the license server. The result is an NX startup error caused by the inability to get a license.

This condition usually occurs when a single user on a laptop installs the license server and NX on the same laptop.

Use one of the following recommendations to help prevent or resolve this situation:

- Install a license server on a workstation or system that has a stable domain. It is recommended that a central license server be used for all client applications.

- Use the local IP address (127.0.0.1) for the hostname as follows.
  
  Change the file from:

  ```
  SERVER Yourhostname COMPOSITE=a1234567890b 28000
  ```
To:

SERVER 127.0.0.1 COMPOSITE=a1234567890b 28000

When asked for the license server value during the client application install, provide the following:

28000@127.0.0.1

- Request a standalone non-served license file. These license files do not need a license server but simply need to have the application point to a file. These license files are ideal for a user with only one seat of an application that is to be installed on a laptop. Contact your customer service representative for a standalone license file.

Common licensing tool on Mac OS X

The Common Licensing Tool (CLT) for Mac OS X is a licensing utility that enables the user to select bundles and borrow licenses.

Bundle selection

The interface to the Bundle Selection in the CLT for Mac is essentially the same as in the License Options application on Windows.

In order to select a bundle, you highlight the bundle in the Available Bundle list and click the Add button, or double click the selected item. The item is moved to the Selected Bundle list.

To remove an item from the Selected Bundle list and return it to the Available Bundle list, you can highlight the bundle you wish to return to the Available Bundle list and click the Remove button. Alternatively, you can double click the bundle to remove it from the Selected Bundle list.

No bundles are actually applied until you click OK. When you click OK, the modifications to the selected bundle list are written to a file in the user’s home directory, called splms_cl.reg.

The CLT for Mac allows for product-specification in the bundle settings. Thus, the name of the key for the bundle value is <PRODUCT>_BUNDLES, where <PRODUCT> is the product in question (such as NX, in which case the key would be NX_BUNDLES).

Borrowing

Borrowing with the CLT is similar to borrowing with License Options for Windows. To borrow a license feature or features, you select the features that you want and then choose the return date and time. Then you click the Borrow License(s) button. Finally, to perform the actual communication with the license server and borrow the selected items, click OK.

To return a borrowed license, you select the item you want to return, click the Return License(s) button, and then click OK.

The Reset button will cause all Return Dates to go back to the original state they were in when you initially launched the tool. Thus, items that were not borrowed will have their return dates cleared, and any items that had the return date changed or cleared will be reset to their original value when the tool was launched.
## Product compatibility - supported version combinations

### Teamcenter and NX

The following table lists the version combinations of Teamcenter and NX that are supported.

<table>
<thead>
<tr>
<th>Teamcenter UA</th>
<th>NX 8.5.3</th>
<th>NX 9</th>
<th>NX 9.0.x</th>
<th>NX 10</th>
<th>NX 10.0.x</th>
<th>NX 11</th>
<th>NX 11.0.x</th>
<th>NX 12</th>
</tr>
</thead>
<tbody>
<tr>
<td>8.3</td>
<td><img src="1" alt="Check" /></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9.1</td>
<td><img src="2" alt="Check" /></td>
<td><img src="4" alt="Check" /></td>
<td><img src="4" alt="Check" /></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10.1</td>
<td><img src="3" alt="Check" /></td>
<td><img src="5" alt="Check" /></td>
<td><img src="5" alt="Check" /></td>
<td><img src="6" alt="Check" /></td>
<td><img src="6" alt="Check" /></td>
<td><img src="10" alt="Check" /></td>
<td><img src="10" alt="Check" /></td>
<td><img src="13" alt="Check" /></td>
</tr>
<tr>
<td>11.2</td>
<td><img src="7" alt="Check" /></td>
<td><img src="8" alt="Check" /></td>
<td><img src="11" alt="Check" /></td>
<td><img src="11" alt="Check" /></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11.3</td>
<td><img src="9" alt="Check" /></td>
<td><img src="12" alt="Check" /></td>
<td><img src="14" alt="Check" /></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

(1) Teamcenter UA 8.3.3.6 or higher.
(2) Teamcenter UA 9.1.2 or higher.
(3) Teamcenter UA 10.1.0.1 or higher.
(4) Teamcenter UA 9.1.2.4 or higher.
(5) Teamcenter UA 10.1.0.1 or higher.
(6) Teamcenter UA 10.1.2.2 or higher.
(7) NX 10.0.2: For Teamcenter UA 11.2.0 through 11.2.1, NX 10.0.2 MP1 or higher. For Teamcenter UA 11.2.2 and higher, NX 10.0.2 MP 11 or higher.
(8) NX 10.0.3: For Teamcenter UA 11.2.0 through 11.2.1, NX 10.0.3 or higher. For Teamcenter UA 11.2.2 and higher, NX 10.0.3 MP 10 or higher.
(9) NX 10.0.3 MP10 or higher.
(10) Teamcenter UA 10.1.5 or higher.
(11) For Teamcenter UA 11.2.2, NX 11 or higher. For Teamcenter UA 11.2.3, NX 11.0.0 MP3 or higher.
(12) NX 11.0.0 MP3 or higher.
(13) Teamcenter UA 10.1.7 or higher.
(14) Teamcenter UA 11.3.0.1_a01 or higher.
**Note**

For information on version compatibility for Teamcenter and Teamcenter lifecycle visualization, see the Teamcenter documentation.

**NX and Active Workspace with Teamcenter**

The following table lists the version combinations of NX and Active Workspace that are supported. The Teamcenter versions listed in each table cell are the minimum versions applicable for both the Active Workspace version and NX version.

<table>
<thead>
<tr>
<th></th>
<th>NX 10</th>
<th>NX 10.0.1</th>
<th>NX 10.0.2</th>
<th>NX 10.0.3</th>
<th>NX 11</th>
<th>NX 11.0.1</th>
<th>NX 11.0.2</th>
<th>NX 11.0.2 MP2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active Workspace</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>TC 2.3</td>
<td>10.1.2.3</td>
<td>10.1.2.3</td>
<td>10.1.3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Active Workspace</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>TC 2.4</td>
<td>10.1.4</td>
<td>10.1.4</td>
<td>10.1.4</td>
<td>TC 10.1.4</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Active Workspace</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>TC 3.0</td>
<td>10.1.5</td>
<td>TC 11.2.1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Active Workspace</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>TC 3.1</td>
<td>10.1.5</td>
<td>TC 11.2.1</td>
<td>TC 11.2.2</td>
<td>TC 10.1.5</td>
<td>TC 11.2.2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Active Workspace</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>TC 3.2</td>
<td>10.1.5</td>
<td>TC 11.2.1</td>
<td>TC 11.2.2</td>
<td>TC 10.1.5</td>
<td>TC 11.2.2</td>
<td>AW 3.2.1</td>
<td>TC 10.1.5</td>
<td></td>
</tr>
<tr>
<td>Active Workspace</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>TC 3.3</td>
<td>10.1.5</td>
<td>TC 11.2.1</td>
<td>TC 11.2.2</td>
<td>TC 10.1.5</td>
<td>TC 11.2.2</td>
<td>AW 3.3.1</td>
<td>TC 10.1.5</td>
<td>TC 11.2.2</td>
</tr>
<tr>
<td>Active Workspace</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>TC 3.4</td>
<td>10.1.5</td>
<td>TC 11.2.1</td>
<td>TC 11.2.2</td>
<td>TC 10.1.5</td>
<td>TC 11.2.2</td>
<td></td>
<td>TC 10.1.5</td>
<td>TC 11.2.2</td>
</tr>
</tbody>
</table>
## NX compatibility with Spreadsheet

| Platform verison
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows 10 64–bit</td>
<td>10 Pro &amp; Enterprise</td>
<td>Supported</td>
<td>Supported</td>
<td>Not supported</td>
<td>Not supported</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Windows 8 64–bit</td>
<td>8 Pro &amp; Enterprise</td>
<td>Supported</td>
<td>Supported</td>
<td>Not supported</td>
<td>Not supported</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Windows 7 64–bit</td>
<td>7 Pro &amp; Enterprise</td>
<td>Supported</td>
<td>Certified &amp; supported</td>
<td>Not supported</td>
<td>Not supported</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Linux 64–bit</td>
<td>Suse Enterprise</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SuSE 12</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Linux V7</td>
<td>Red Hat Enterprise</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Red Hat V7</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Note

- The NX spreadsheet interface is not supported on the MAC platform in NX 12.
- The 64-bit versions of Microsoft Excel are not yet supported by NX. The 32-bit version of Excel is installed by default on the Windows 64-bit Operating Systems.
- Microsoft Starter Edition is not supported by NX due to lack of support for Add-in's, Macro's, Math and Equation Editing.
- If you open a part with Excel 2003 data or older and then save the spreadsheet, NX updates the data to Excel 2007 or later (to the Excel version currently running with NX).
- If you launch a spreadsheet command such as Spreadsheet or Part Family on a system having Excel 2003 or older version as the default spreadsheet application, NX displays an error message and does not proceed with the launched command.

NX support for the currently supported versions of Microsoft Office will be discontinued as per the following dates:

1. When you launch Excel 2016 spreadsheet from NX and exit the spreadsheet using the Windows Close button, Excel launches a dialog box prompting you to either accept the changes, discard the changes and exit, or to cancel the spreadsheet exit. If you select the cancel operation, subsequent use of the Windows Close button will close the spreadsheet without displaying the dialog box described above and does not return control back to NX. At this point, you may need to terminate the NX process. To avoid this situation use the Excel File tab—Close command instead of the Windows Close button. A fix for this issue is expected in a future version of Microsoft Excel 2016.
<table>
<thead>
<tr>
<th>Microsoft Office version</th>
<th>End of support</th>
</tr>
</thead>
<tbody>
<tr>
<td>2007</td>
<td>October 11, 2017</td>
</tr>
<tr>
<td>2010</td>
<td>October 13, 2020</td>
</tr>
<tr>
<td>2013</td>
<td>April 11, 2023</td>
</tr>
<tr>
<td>2016</td>
<td>October 14, 2025</td>
</tr>
</tbody>
</table>
### NX applications unsupported on specific platforms

The applications listed are not supported on the specified platforms.

<table>
<thead>
<tr>
<th>Application</th>
<th>Functionality</th>
<th>Platform</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gateway</td>
<td>File Print</td>
<td>Not supported on: Linux, MAC</td>
</tr>
<tr>
<td></td>
<td>File Open of SolidWorks files</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Advanced Studio Rendering Style Mode</td>
<td></td>
</tr>
<tr>
<td>Plotting</td>
<td>Plotting of high quality images using the <code>View→Visualization→High Quality Image</code> command</td>
<td>Not supported on: MAC</td>
</tr>
<tr>
<td>Manufacturing Milling</td>
<td>Siemens 840D virtual machine tool controller (VNCK)</td>
<td>Not supported on: Linux, MAC</td>
</tr>
<tr>
<td></td>
<td>Manufacturing Wizard Builder (part of Simulation Process Studio)</td>
<td></td>
</tr>
<tr>
<td>Pre/Post</td>
<td>Abaqus OBD result file reading</td>
<td>Not supported on: Linux</td>
</tr>
<tr>
<td>Pre/Post</td>
<td>All</td>
<td>Not supported on: MAC</td>
</tr>
<tr>
<td>Design Simulation</td>
<td>All</td>
<td>Not supported on: MAC</td>
</tr>
<tr>
<td>Motion</td>
<td>Motion Mechatronics co-simulation</td>
<td>Not supported on: Linux</td>
</tr>
<tr>
<td>Motion</td>
<td>All</td>
<td>Not supported on: MAC</td>
</tr>
<tr>
<td>Teamcenter Integration</td>
<td>Launching NX from Active Workspace web client</td>
<td>Not supported on: MAC</td>
</tr>
<tr>
<td>Human Modeling</td>
<td>All</td>
<td>Not supported on: Linux, MAC</td>
</tr>
<tr>
<td>PCB Exchange</td>
<td>Automatic creation of ESC solution</td>
<td>Not supported on: MAC</td>
</tr>
<tr>
<td></td>
<td>CR5000 pcb files Import / Export / Compare (PCB Exchange for Zuken limitation)</td>
<td></td>
</tr>
<tr>
<td>Mechatronics Concept Designer</td>
<td>All</td>
<td>Not supported on: Linux, MAC</td>
</tr>
<tr>
<td>CMM Inspection Programming</td>
<td>All</td>
<td>Not supported on: Linux, MAC</td>
</tr>
<tr>
<td>Simple NX Application Programming</td>
<td>All</td>
<td>Not supported on: Linux, MAC</td>
</tr>
<tr>
<td>Programming (SNAP)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Support for touch enabled devices

In NX 12, you can interact and manipulate 3D models and control the overall user interface using touch screen and stylus. The support for touch enabled hardware follows a slightly different support model than what is provided through the NX certification program. We have tested NX on a number of Windows based touch screen laptops, monitors, and tablets. However, support for these devices and other comparable systems is limited as they are not true workstations and do not qualify for our full certification program. Support for these devices is limited as follows:

- Graphics performance issues are not supported as most of these devices do not offer the level of driver support available on workstations.

- Graphics quality and display issues are not supported unless they can be duplicated on a certified workstation.

- Any issue determined to be caused by the graphics driver is not supported.

- Performance issues with NX are not supported on these systems unless reproducible on certified workstations.

Caveats aside, we have tested and used for development a variety of touch based systems from HP, Dell, Microsoft, and others and have found them acceptable for general usage of NX.

Additional Notes

- NX supports touch devices on Windows 7, Windows 8, and Windows 10 operating system.

- Only stylus configurations support pre-highlighting. The most commonly used devices supporting stylus are the Surface Pros.
Chapter 2: Teamcenter Integration for NX
Product Notes

Refile utility to be retired

Historically, the NX product release has included the refile utility, which was created many years ago for very specific data conditions and was never intended to be run by all customers on all of their data. This utility was never mandatory when performing NX upgrades.

NX product enhancements and improvements that are delivered and available in the current NX release make NX upgrades much faster and easier, so the refile utility is now obsolete. As a result, the refile utility is retired starting in NX 12.0.1. The documentation for the utility has already been removed in NX 12.

In place of the refile utility, standalone utilities will be introduced that incorporate non-version-up related options and future NX batch processes.

Teamcenter names and values of properties localized

In Teamcenter, there is now the capability to have the names and values of properties translated and displayed in multiple languages. You can see this functionality in some areas of NX (not all areas of NX incorporate this functionality), such as the Part Family template spreadsheet, and New Item, Save, Save As, Import, and component properties dialog boxes. This is applicable for Teamcenter properties such as: property names, property values, list of values, and BMIDE elements (type names).

Note

This functionality is applicable for Teamcenter 11.2 or higher.

When you run NX, the language set by the environment variable UGII_LANG determines the language that is used to display the names and values of TC properties in NX.

If you do not have translated values defined in TC for the properties, or you do not want NX to display the translated values, set the following environment variable:

UGII_NO_TC_LOCALIZATION=1

When this environment variable is set, the property values shown in NX are always the internal value (non-translated) and there is no indication in NX that the value has a translated value defined in Teamcenter. This is the same behavior that NX had prior to NX 10. However, the environment variable does not change the way the property names are displayed. If the property name has a translated value that matches the UGII_LANG setting, the translated (localized) name is still shown in NX.
Caveats

Starting NX in four-tier Teamcenter environment with WebLogic 10 MP2

When you are running Teamcenter in the four-tier environment with WebLogic 10 MP2, NX may not start with no error messages displayed. This could be due to problems with the WebLogic server.

**Note**

This is applicable only when you are using the WebLogic 10 MP2 Application Server.

Perform the following steps to modify the Weblogic XML file:

1. Stop the WebLogic application and locate the tc.war file in the WebLogic domain (typically in the autodeploy directory).

2. Open the tc.war file using Winzip and extract the weblogic.xml file to a temporary location.

3. Open the weblogic.xml file using an editor (XML or text editor) and add a `cookie-http-only` XML element with the value of false in the `session-descriptor` element. For example:

   ```xml
   <session-descriptor>
   ...<cookie-http-only>false</cookie-http-only>
   </session-descriptor>
   ```

4. In Winzip, delete the old weblogic.xml file.

5. Add the modified weblogic.xml file in your temporary directory into Winzip. To do this, drag the web-inf folder that contains the weblogic.xml file and drop it into Winzip. Ensure the path of the weblogic.xml file is web-inf/.

6. Restart the WebLogic application.

Creating an Alt Rep assembly using File New

You cannot have an assembly that is an alternate representation (Alt Rep) that has children that are not also Alt Reps. The part types of the parts (Alt Rep) must match the part type of the assembly (Alt Rep).

However, when you choose File→New to create a new assembly and use the Blank template, NX lets you create an Alt Rep assembly with children that are not also Alt Reps. This causes problems when you use the assembly in NX.

Translators only supported in Teamcenter two-tier environment

Teamcenter only supports the installation of the following NX translators in a Teamcenter two-tier environment, the Teamcenter four-tier environment is not supported:

- NXClone
- NXtoPVDirect
VLA Attribute Affix options modified

The VLA Attribute Affix customer default (Teamcenter Integration for NX—User Attributes, All tab) is modified. The new options [Numeric] and :Numeric introduced in NX 8 caused problems when there are references to VLA (variable length array) attributes in parts created prior to NX 8. The [Numeric] and :Numeric options are now set to _Numeric when selected. You should use _Numeric if you are setting this option for the first time.
Chapter 3: Fundamentals
Product Notes

Multiple windows support on various operating systems

Multiple windows are supported only on the Windows and Linux operating system. Multiple windows are not supported on the Mac operating system.

Refile utility to be retired

Historically, the NX product release has included the refile utility, which was created many years ago for very specific data conditions and was never intended to be run by all customers on all of their data. This utility was never mandatory when performing NX upgrades.

NX product enhancements and improvements that are delivered and available in the current NX release make NX upgrades much faster and easier, so the refile utility is now obsolete. As a result, the refile utility is retired starting in NX 12.0.1. The documentation for the utility has already been removed in NX 12.

In place of the refile utility, standalone utilities will be introduced that incorporate non-version-up related options and future NX batch processes.

Classic Toolbar user interface retired from the Windows platform

The Classic Toolbar user interface is retired from NX11 and the Ribbon Bar is the only available user interface on Windows. The Ribbon Bar interface provides access to more commands than the Advanced role in Classic Toolbar mode with a larger graphics window. And it does all this with logical groupings, informative text and a mixture of icon sizes. In addition to these traditional aspects of the Ribbon Bar, the NX ribbon is fully customizable and contains NX-specific extensions such as border bars. The result is a more organized user interface with the richness of Advanced and the discoverability of Essentials.

For instructions on how to migrate from Classic interface to Ribbon bar interface, see NX Ribbon-Customization and Transition.
**Caveats**

**Bookmarks**

If you create a bookmark file with Ray Traced Studio mode enabled, when the bookmark is applied Ray Traced Studio mode will not be in effect.

If you create a bookmark file when displaying a View Section with clipping disabled, when the bookmark is applied the section may be incorrectly clipped.

If you try to apply a bookmark file when

1. the bookmark file is not for the current displayed part and
2. the number of views in the layout at the time when the bookmark file was created is not the same as the number of views in the current displayed part

then the number of views in the layout may be wrong after the bookmark file is applied. Applying the same bookmark file a second time corrects the number of views.

**Ray Traced Studio**

To maximize rendering performance for NX 11.0.1, you need an NVIDIA GPU with CUDA Compute Capability 2.0 and higher, and a graphics driver supporting CUDA 8.0 or higher (For NVIDIA driver version, contact GTAC)

---

**Note**

Users upgrading to NX11.0.1 may need to upgrade to a later NVIDIA graphics driver version for CUDA 8.0 support.

Because some driver versions supporting CUDA 8.0 have incorrect documentation stating they only support CUDA 7.5, the NVIDIA Control Panel should be checked to verify the actual CUDA version supported.

---

**Tip**

The current CUDA version supported by the NVIDIA graphics driver can be obtained using the NVIDIA Control Panel→System Information→Components tab→3D Settings→<Product Name for NVCUDA>
Using Teamcenter as the issue site for NX Issue Management

When you use NX Issue Management, you can specify Teamcenter as the issue site only when Teamcenter Issue Manager is deployed via Teamcenter Environment Manager at the server side. NX displays an error message if it cannot connect to Teamcenter Issue Manager. For more information, refer to the Teamcenter Environment Manager Help.
Chapter 4: Customer Defaults
Customer defaults

Customer defaults allow you to customize the operation of NX. The initial settings and parameters of many functions and dialog boxes are controlled by customer defaults. You can view them by choosing **File→Utilities→Customer Defaults**.

For a description of the new/modified customer defaults for this release, see Customer Defaults for NX 12.

For additional information on customer defaults, see System administration→Customizing the NX installation→Customer Defaults in the NX online help. For a listing and description of all customer defaults, see Fundamentals→Customer Defaults in the NX online help.
Chapter 5: Design (CAD)

Modeling

Product Notes

Commands being retired in NX 12

The following commands have been dropped from the product line in NX 12 and are no longer available:

- Emboss Sheet
- Move Defining Point
- Move Pole
- Isoparametric Trim/Divide

Commands to be retired in a future release of NX

The following commands will be retired in a future release of NX and are now hidden so that Command Finder will no longer list them.

- Join Curve
- Stretch Curve
- Fillet Sheet

- Spline—It is recommended that you use Studio Spline instead of the legacy Spline command.

These commands are hidden in the menu bar menu and removed from any ribbon, toolbar, shortcut menu, and radial toolbar. Until they are retired, these commands can be brought back into NX using the Customize command, where they will appear with “(to be retired)” appended to their names.
Documentation Notes

Rough Brush Selection accelerators
The following tip was prematurely included in several Convergent command topics, as the functionality will not apply until the NX 12.0.1 release:

**Tip**
You can also press the shift key and rotate the mouse wheel to increase or decrease the brush size, instead of selecting the dialog box.

Please disregard this tip for the following Convergent commands in NX 12:

- Snip Facet Body
- Paint Facet Body
- Decimate Facet Body
- Subdivide Facet Body
- Divide Facet Face
- Smooth Facet Body
- Local Offset

Drafting

Product Notes

Annotation and dimension stability fixes

- After you designate a new associative point for the leader line of a retained annotation, the annotation no longer appears retained.
  
  In previous NX versions, the retained annotation would continue to appear retained, even after the leader line was associated to new geometry.

**Note**
This enhancement only applies to annotation with the following criteria:

- It is created in NX 12 or later.
- The **Position Relative to Geometry** alignment option was set in the **Origin** group of the dialog box when the annotation was created.
- The annotation was created with a **Plain**, **All Around**, **All Over**, or **Without Stub** type leader line. All other leader line types are not supported.

- When you apply a dimension to a silhouette edge but make no changes to the model, the dimension's value does not change when you update the drafting view.
Previously, when you updated a drafting view, the dimension's original value would change even when no model change occurred.

Correct Flipping of Inherited PMI on Drawings

In NX12, inherited PMI on drawings has been updated to always look like PMI from the parent model view. When the orientation of the model view is changed, the inherited PMI will be updated. The inherited PMI will always be readable with this update. Notable cases include:

- Parts created using **WAVE → Create Linked Mirror Parts**
- Parts where the component PMI is displayed at the assembly level
- Parts where the PMI is created in one model view and displayed in another model view

**No support for Arial Unicode MS font with Office 2016**

A service bulletin, SFB-NX-11528, was issued on July 27, 2017 to announce that the NX default font, **Arial Unicode MS**, is no longer being shipped with Microsoft’s Office 2016 product.

If your NX system, customer defaults, and parts are set such that they do not use **Arial Unicode MS** font, then there is no action required on your part. However, if you use the NX default font type, which was **Arial Unicode MS** on the Windows and Mac OS platforms, then you may wish to take one of the following actions:

- If Microsoft Office 2013 or earlier was installed on your machine, and then it was updated to Office 2016, the **Arial Unicode MS** font file still resides on your machine. As such, no further action is required.

- If you install Microsoft Office 2106 on a new machine, or a machine that has been rebuilt, then the **Arial Unicode MS** font file will not be installed. In this case, you will need to obtain a copy of the font file and manually install it on your machine if you wish to continue to use the **Arial Unicode MS** font. You can obtain a copy of the font file here: [https://www.fonts.com/font/monotype/arial-unicode](https://www.fonts.com/font/monotype/arial-unicode).

Please note that there is a license cost associated with this font file.

Prior to NX 12, **Arial Unicode MS** was the primary default font used by NX on the Windows and Mac OS platforms. **Tahoma** and **Arial** were the secondary and tertiary default font files, if the primary (and secondary) font files were not found.

The following table displays the primary, secondary, and tertiary default fonts for supported platforms prior to NX 12.

<table>
<thead>
<tr>
<th>Windows</th>
<th>Mac OS</th>
<th>Linux</th>
</tr>
</thead>
<tbody>
<tr>
<td>Arial Unicode MS</td>
<td>Arial Unicode MS</td>
<td>DejaVu Sans</td>
</tr>
<tr>
<td>Tahoma</td>
<td>Tahoma</td>
<td>Lucida Sans</td>
</tr>
<tr>
<td>Arial</td>
<td>Arial</td>
<td>Nimbus Sans L</td>
</tr>
</tbody>
</table>

**Default fonts and Customer Default fonts prior to NX 12**

**Arial Unicode MS** is also the font file that the drafting standards files reference for text font types on the Windows and Mac OS platforms (DejaVu Sans on the Linux platform). Siemens PLM Software
selected Arial Unicode MS font as the default font type because the font supports a large array of characters.

Since the Arial Unicode MS font is no longer shipped with Office 2016, Siemens PLM Software replaced the primary default font with the Arial font. The following table displays the primary, secondary, and tertiary default fonts for supported platforms as of NX 12.

<table>
<thead>
<tr>
<th>Windows</th>
<th>Mac OS</th>
<th>Linux</th>
</tr>
</thead>
<tbody>
<tr>
<td>Arial</td>
<td>Arial</td>
<td>DejaVu Sans</td>
</tr>
<tr>
<td>Tahoma</td>
<td>Tahoma</td>
<td>Lucida Sans</td>
</tr>
<tr>
<td>Calibri</td>
<td>Calibri</td>
<td>Nimbus Sans L</td>
</tr>
</tbody>
</table>

**Default fonts and Customer Default fonts in NX 12**

As a consequence of this default font change, it is important to be aware of the following:

- In the NX 12 drafting standards files, font types that were previously set to Arial Unicode MS are now set to Arial. You will need to modify your customer defaults if you wish to continue to use the Arial Unicode MS font. If you import your previous drafting customer defaults to the new drafting customer defaults using the Import Drafting Standard tool, Arial will be overwritten with the fonts from the previous customer defaults file. If the previous customer default settings were Arial Unicode MS and that font no longer resides on your machine, you are advised to change your final default font settings to Arial or to another font type.

**Note**

Only the following customer default files used the Arial Unicode MS font.

- nx_ASME_Drafting_Standard_Shipped.dpv
- nx_DIN_Drafting_Standard_Shipped.dpv
- nx_ISO_Drafting_Standard_Shipped.dpv
- nx_Shipbuilding_Drafting_Standard_Shipped.dpv

- If you open a drawing with text that uses the Arial Unicode MS font, and you do not have the font file installed, the text displayed in the drawing will change to one of the default fonts listed above. However, NX retains the fact that the text was originally created with an Arial Unicode MS font. If you reinstall the Arial Unicode MS font file on your computer, the text on the drawing reverts to its original state. This may be important if you wish to maintain drawing parity with previous versions of NX.

- The Arial font (as well as Tahoma and Calibri) do not have as large a character set as the Arial Unicode MS font. If a character is encountered that is not supported by the current font, a box is displayed instead of the character. This is standard NX behavior. To correct this situation, you will need to use a font that supports the character.

- Sample templates supplies by NX, including drawing templates, now use Arial font. If you wish to use NX supplied templates with Arial Unicode MS font instead, you will need to reset the text
fonts in the templates, or copy the templates from the previous NX version to the NX 12 template directory. See the Help documentation on using templates for additional information.

- NX supplied custom symbols do not reference text. However, any custom symbols, seed parts, templates, or NX files that you created and use in your NX environment may contain text that uses the **Arial Unicode MS** font. If you want those custom symbols and files to use the new default font, you may want to change the text font in those files. However, this is optional because NX will use the default font (**Arial**, **Tahoma**, or **Calibri** on Windows and Mac OS) if the current font is not found.
Documentation Notes

Weld Symbol Display

- The ID line is now the same length as the reference line, including the stub.
- The dashes for the ID line are now aligned with the start of the reference line, including the stub, and the end of the reference line.
- The weld symbols displayed on the Other Side and Arrow Side are now aligned correctly when using the No Staggered Symbol option.
Caveats

Multiple part display caveats

The display of your drawing in an inactive window may be affected if you switch to an application that only supports the display of content in the active window.

Layout

Product Notes

Create from 3D

When you use the Create from 3D command, you can now select lightweight components without first setting the Load Smart Lightweight Data customer default. Assembly performance improvements made that default obsolete in NX 12.0. Now smart lightweight data is loaded whenever NX needs it to complete an action.

Product and Manufacturing Information (PMI)

Product Notes

Annotation and dimension stability fixes

After you designate a new associative point for the leader line of a retained annotation, the annotation no longer appears retained.

In previous NX versions, the retained annotation would continue to appear retained, even after the leader line was associated to new geometry.

Note

This enhancement only applies to annotation with the following criteria:

- It is created in NX 12 or later.
- The Position Relative to Geometry alignment option was set in the Origin group of the dialog box when the annotation was created.
- The annotation was created with a Plain, All Around, All Over, or Without Stub type leader line. All other leader line types are not supported.

Correct Flipping of Inherited PMI on Drawings

In NX12, inherited PMI on drawings has been updated to always look like PMI from the parent model view. When the orientation of the model view is changed, the inherited PMI will be updated. The inherited PMI will always be readable with this update. Notable cases include:
• Parts created using **WAVE→Create Linked Mirror Parts**
• Parts where the component PMI is displayed at the assembly level
• Parts where the PMI is created in one model view and displayed in another model view

**Geometric Tolerancing Module planned retirement**

The **Geometric Tolerancing** command will be retired in the next release. This command is hidden in the Menu, removed from the Ribbon bar, and short-cut menus; however, it can still be customized into the UI. The command retirement will not impact existing data, but will impact the ability to create new data.

**No support for Arial Unicode MS font with Office 2016**

A service bulletin, SFB-NX-11528, was issued on July 27, 2017 to announce that the NX default font, **Arial Unicode MS**, is no longer being shipped with Microsoft’s Office 2016 product.

If your NX system, customer defaults, and parts are set such that they do not use **Arial Unicode MS** font, then there is no action required on your part. However, if you use the NX default font type, which was **Arial Unicode MS** on the Windows and Mac OS platforms, then you may wish to take one of the following actions.

• If Microsoft Office 2013 or earlier was installed on your machine, and then it was updated to Office 2016, the **Arial Unicode MS** font file still resides on your machine. As such, no further action is required.

• If you install Microsoft Office 2106 on a new machine, or a machine that has been rebuilt, then the **Arial Unicode MS** font file will not be installed. In this case, you will need to obtain a copy of the font file and manually install it on your machine if you wish to continue to use the **Arial Unicode MS** font. You can obtain a copy of the font file here: [https://www.fonts.com/font/monotype/arial-unicode](https://www.fonts.com/font/monotype/arial-unicode).

Please note that there is a license cost associated with this font file.

Prior to NX 12, **Arial Unicode MS** was the primary default font used by NX on the Windows and Mac OS platforms. **Tahoma** and **Arial** were the secondary and tertiary default font files, if the primary (and secondary) font files were not found.

The following table displays the primary, secondary, and tertiary default fonts for supported platforms prior to NX 12.

<table>
<thead>
<tr>
<th>Windows</th>
<th>Mac OS</th>
<th>Linux</th>
</tr>
</thead>
<tbody>
<tr>
<td>Arial Unicode MS</td>
<td>Arial Unicode MS</td>
<td>DejaVu Sans</td>
</tr>
<tr>
<td>Tahoma</td>
<td>Tahoma</td>
<td>Lucida Sans</td>
</tr>
<tr>
<td>Arial</td>
<td>Arial</td>
<td>Nimbus Sans L</td>
</tr>
</tbody>
</table>

**Default fonts and Customer Default fonts prior to NX 12**

**Arial Unicode MS** is also the font file that the drafting standards files reference for text font types on the Windows and Mac OS platforms (DejaVu Sans on the Linux platform). Siemens PLM Software selected **Arial Unicode MS** font as the default font type because the font supports a large array of characters.
Since the Arial Unicode MS font is no longer shipped with Office 2016, Siemens PLM Software replaced the primary default font with the Arial font. The following table displays the primary, secondary, and tertiary default fonts for supported platforms as of NX 12.

<table>
<thead>
<tr>
<th>Windows</th>
<th>Mac OS</th>
<th>Linux</th>
</tr>
</thead>
<tbody>
<tr>
<td>Arial</td>
<td>Arial</td>
<td>DejaVu Sans</td>
</tr>
<tr>
<td>Tahoma</td>
<td>Tahoma</td>
<td>Lucida Sans</td>
</tr>
<tr>
<td>Calibri</td>
<td>Calibri</td>
<td>Nimbus Sans L</td>
</tr>
</tbody>
</table>

**Default fonts and Customer Default fonts in NX 12**

As a consequence of this default font change, it is important to be aware of the following:

- In the NX 12 drafting standards files, font types that were previously set to Arial Unicode MS are now set to Arial. will need to modify your customer defaults if you wish to continue to use the Arial Unicode MS font. If you use the drafting standards files to manage your PMI default settings then please be aware that if you import your previous drafting customer defaults to the new drafting customer defaults using the Import Drafting Standard tool, Arial will be overwritten with the fonts from the previous customer defaults file. If the previous customer default settings were Arial Unicode MS and that font no longer resides on your machine, you are advised to change your final default font settings to Arial or to another font type.

**Note**

Only the following customer default files used the Arial Unicode MS font.

- `nx_ASME_Drafting_Standard_Shipped.dpv`
- `nx_DIN_Drafting_Standard_Shipped.dpv`
- `nx_ISO_Drafting_Standard_Shipped.dpv`
- `nx_Shipbuilding_Drafting_Standard_Shipped.dpv`

- If you open a part with PMI text that uses the Arial Unicode MS font, and you do not have the font file installed, the text will change to one of the default fonts listed above. However, NX retains the fact that the text was originally created with an Arial Unicode MS font. If you reinstall the Arial Unicode MS font file on your computer, the text reverts to its original state. This may be important if you wish to maintain part parity with previous versions of NX.

- The Arial font (as well as Tahoma and Calibri) do not have as large a character set as the Arial Unicode MS font. If a character is encountered that is not supported by the current font, a box is displayed instead of the character. This is standard NX behavior. To correct this situation, you will need to use a font that supports the character.

- Sample templates supplies by NX now use Arial font. If you wish to use NX supplied templates with Arial Unicode MS font instead, you will need to reset the text fonts in the templates, or copy the templates from the previous NX version to the NX 12 template directory. See the Help documentation on using templates for additional information.
• NX supplied custom symbols do not reference text. However, any custom symbols, seed parts, templates, or NX files that you created and use in your NX environment may contain text that uses the Arial Unicode MS font. If you want those custom symbols and files to use the new default font, you may want to change the text font in those files. However, this is optional because NX will use the default font (Arial, Tahoma, or Calibri on Windows and Mac OS) if the current font is not found.
Documentation Notes

Convert drafting annotation created in 3D legacy models in batch mode

The ConvertToPMI utility program supports the conversion of drafting annotation created in 3D legacy models.

The Convert to PMI enhancements What's new topic in this release erroneously indicates that you must set DRAFTANN=yes and DRAFTANNDEL=yes. This is not necessary.

If you want to convert drafting annotation created in 3D legacy models, use DRAFTANN or DRAFTANNDEL as command line options for batch processing.

- **DRAFTANN**—Converts drafting annotation used in 3D models from the specified source part.
- **DRAFTANNDEL**—Converts and deletes all drafting annotation used in 3D models from the specified source part.

Routing

Caveats

Placement of eccentric reducers

If the NPS and NPS_BRANCH attributes are not present on the ports of a reducer, you might not get the correct placement solution while placing the pipe. If you place such a part, you might not be able to move it as expected using the Move Part command.

Moving parts

You cannot move a routing component using the Move Part command if the customer default for the selection scope of the Move Component command is set to Anywhere in Assembly.

Tip

To find a customer default, choose File tab→Utilities→Customer Defaults, and click Find Default.

Color bleeding in harness displays

If the color bleeds through in the display of harnesses, use the Refinement Factor visualization preference to correct the display. The factor you must set varies depending on the part that is open.

In the Visualization Preferences dialog box→Faceting tab→Part Settings group, use the:

- **Shaded Views** subgroup→Refinement Factor option to adjust the display in a shaded view.
- **Advanced Visualization Views** subgroup→Refinement Factor option to adjust the display in advanced studio views.
**Teamcenter Classification**

The Teamcenter Classification plug-in is now obsolete. You can use the out-of-the-box support for classification by setting the Teamcenter classification options in the **Part Library** customer defaults.

**Tip**

To find a customer default, choose **File tab→Utilities→Customer Defaults**, and click **Find Default**.

You can use the Reuse Library for classification without setting up additional plug-ins.
Documentation Notes

Structure of a PTB file

The topic *Structure of a PTB file* erroneously states that NX uses the descriptor characteristics in the list of table columns in a PTB file to search for parts in the **Routing Reuse Search** dialog box. In reality, NX only displays the characteristics in the **Routing Reuse Search** dialog box. The switch /HIDE indicates that you do not want NX to show the characteristic in the **Routing Reuse Search** dialog box during part placement.

Note that the destination characteristics defined under specific disciplines in the APV file are used when you search for parts. This is not necessarily the same as what is displayed.

Unify Path enhancement

In previous releases, NX did not unify paths when direct mount parts or eccentric segments were a part of your selection. Parts that were placed using the **Instance Name Lookup** command and which were part of a run were ignored when you used the **Unify Path** command.

In NX 9.0.2 and later, in addition to the conditions mentioned above, NX does not unify a path that has an eccentric reducer part or any other routing part which has the **NX_BLOCK_UNIFY** attribute set to **TRUE** in the respective PTB file.

Parts which are placed using the **Instance Name Lookup** command are now ignored when you use the **Unify Path** command, even when the parts are not part of a run.
**Product Notes**

**Propagation of attributes on a run**

NX does not automatically propagate attributes that are specific to a run to the Member items of the run.

To see all the run-level attributes of the member of a run, such as a component or a segment, right-click the object in the graphics window and choose **Report Run Attributes**.

**Renaming stock components in Teamcenter Integration for NX**

To change the name of a stock component that is not yet saved, use the **Rename Stock** command.

To change the name of a stock component that is saved, use the **Make Unique** command or the **Save As → New Item** command.

**Installing standard parts to Classification in Teamcenter**

You can install standard parts to Classification in Teamcenter by using the **Classification Install for Part Library** tool provided in the following folder:

```
UGII_BASE_DIR\ROUTING\ugroute_mech\classification_tool
```

**Opening pre-NX 10 parts in later releases**

Opening pre-NX 10 parts might take longer when you open the part for the first time in a subsequent release.

**Upgrade Stocks command**

When using the **Upgrade Stocks** command on a part that uses Stock As Components and that has multiple levels of Routing assemblies, we recommend that you select the **Work Part and Loaded Children Parts** check box.

**NX Routing - Stock materials and weights**

With NX 12, Routing now supports automatically assigning materials to stock bodies. This has the same result as if the user used Assign Materials and selected a material from the library. Use of this has ramifications for mass and weight calculations.

1. If **Material** is set, then density is fixed.

   Assigning a material also sets and locks the corresponding density of the material on the stock body.

   a. The stock solid body must accurately represent the volume of the real stock.

      • If using the **Simple** stock display style, use **Qualify Part** to include the inner wall in the cross-section. (Essentially making it a **Detailed** stock style.), or never use **Simple** style.
• Make sure that Detailed style is defined with the inner wall correctly. (Display styles are customer configured and can include any geometry)

2. WEIGHT and WEIGHT_UNITS can still be used. WEIGHT here is mass per unit length (for example, its unit can be kilogram per meter). These attributes are used by Routing to automatically adjust the density of stock bodies so that mass calculations are correct regardless of the solid representation with Simple or Detailed stock display styles. This is incompatible with setting the Material which sets and locks the density.

a. If WEIGHT is found as a stock attribute, Routing uses it to set density as in prior releases and will not assign the Material. Material will be ignored.

b. Material can still be set as an attribute on the stock, but the attribute title cannot match the NX Material attributes. That is, it will be treated like any other attribute. That is, decouple the NX Material attributes from the Routing stock attributes.

• In Customer Defaults, under the Gateway→Materials/Mass node→Attributes tab, review the Attribute Title Alias entries for Part Material and Object Material. Verify that these entries do not match any PTB/Classification attributes for stock. Verify the APV configuration file for synonyms to attributes

• Rename any matching attribute names.

**Note**

In Routing Electrical, routed wires and cables are bundled together and represented collectively by a solid body. No material is assigned to these bodies, regardless of stock attributes. WEIGHT, and WEIGHT_UNITS attributes on wire and cable stocks can be used so that Routing will determine and set a density value that results in correct weight calculations for these bundle bodies. This is the same as in pre-NX 12 releases.

**NX Routing part materials and weights**

Routing parts are different from stocks, as parts are standard, and routing does not create them.

Prior to NX 12,Routing would set PTB/Classification attributes with Material as regular attributes. That is, component or instance attributes. This was inconsistent with interactive Material assignments, and for many reasons allowed inconsistent and undesirable behaviors. A WEIGHT attribute in the PTB/Classification was similar.

In NX 12, Routing will no longer set Material attributes on components or instances. Since routing parts are customer created and managed parts, it is recommended that the bodies within these parts, and/or part families have Materials properly assigned there at the source if Material assignment is desired. Part families support Material assignment with the part family table so that each family member can have its own material.

Weights/Mass can require trade-offs. If a Material is assigned to the body, the density is set and locked, and the mass properties are calculated accordingly. If the part is modeled accurately, that is, with the correct volume, then the mass properties will be correct. However, in many cases, as these are standard parts, it is not required or desired to model them with complete accuracy. Also, complete details may not be known. These simplifications likely render the volume, and therefore may compute mass incorrectly.
One solution can be part families. Part family tables support Asserted Mass, where a mass value can be set. However, only the mass itself can be asserted; center of gravity location, and moments of inertia cannot. Any analysis of assemblies using these parts can have accurate masses, but CG and Moments will be marked as certain with no values.

Another solution used today is an unsupported utility provided by Routing, `UFD_Routing_assert_mass.c`. This utility takes a WEIGHT attribute provided in the part family table, and fills in values in a DENSITY column in the part family. These values are set by analyzing each part family member’s volume and determining the density required to get the desired WEIGHT. When a part family member is created the density is set, and regular NX weight calculations are used. There are inherent assumptions in this method, but it generally holds valid. However, this is incompatible with Material assignments. You can either assign the Material and take the material density, or set a density value and not assign a Material, but never both.

Summary

- If parts are modeled completely and correctly, Material can be assigned to bodies without any issue, and mass calculations will be correct.
- If mass calculations are not important, Material can be assigned to bodies without any issue.
- If parts are simplified, and only mass, not center of gravity or moments, is needed, then Assert Mass, Assign Material in part families or to individual parts can be used.
- If parts are simplified, and complete mass properties are required, then the mass utility can be used but Material cannot be assigned.

NX12 locked length spline behavior

Locked length splines behave differently in NX12 than in earlier releases of NX. For example, in NX11, if you add a deformable routing assembly containing a locked length spline to a part, and then move one end of the deformable assembly, the other end of the assembly will move with it to maintain the spline’s locked length value. With NX12, when you move one end of the deformable assembly, the other end of the locked length spline does not move. As a result, the spline may stretch beyond its locked length limit and trigger a design rule violation. This behavior ensures that repositioning a deformable routing assembly does not move any other device in the assembly that it is attached to.

Defining splines using wave-linked ports

When modifying the direction of a wave-linked port, for example, rotating the component that owns the port, the path direction will not update even if it is constrained properly. The direction can be forced to update by suppressing or unsuppressing the parallel constraint associated with the port or extension.

Importing runs

The Import Runs page has been updated to include P&ID. It now states:

You can share runs between schematics applications such as COMOS, P&ID, and NX.

Retired functionality in Routing

The following are retired:

- Active Routing Level Routing preference
• Display Segment Constraints Routing preference
• Manage Associative Paths command
• By Poles option in the Spline Path dialog box
• Variant Conditions command
• Variant Configurations command
• Convert Splines command

The following Routing plug-ins are retired:
• ROUTE_CREATE_FABRICATION
• XML_PREIMPORT
• XML_POSTEXPORT
• SPLIT_DESCRIPTOR

Ship Structure

Caveats

Copy Parts between Planes

The Copy Parts between Planes command does not support Extrude features that are created using the Stop at Intersection selection rule.

CAE Preparation

The Openings Less Than Diameter option in the CAE Preparation dialog box is currently not supported.

Sheet Metal

Caveats

Exporting multi-segment lofted flanges to Trumpf GEO format

Flat Pattern of a model that contains multi-segment lofted flanges cannot be exported to Trumpf GEO format.

Unite in Sheet Metal

If you unite bodies that consist of Sheet Metal and advanced Sheet Metal features, the united body may not support subsequent Sheet Metal operations.
Gusset line representation in flat pattern

Gusset line representation in flat pattern may not appear for the gussets that are created on cylindrical segments of chained bends of advanced and contour flanges.

Material and Bend tables

The tool selection options are not available for the following commands and options.

- Hem Flange
- Lofted Flange
- Convert to Sheet Metal
- Bridge Bend→Type group→Z or U Transition
  Bridge Bend→Type group→Fold Transition→Bend Properties group→Define By list→Length option
- Advanced Flange→Type group→To Reference

Creating multiple flanges

While creating multiple flanges, internal miter cannot be applied if adjacent edges within a set does not belong to the same face.

PCB Exchange

Caveats

Flat Solid workflow

The import and export of ECAD models in their bend state only works when the board is a solid body. If the board is an assembly component this workflow does not work.

PCB Exchange for Zuken

CR5000 Data Server version 16 or earlier requires the Visual C++ 2008 Redistributable package to be installed. You can download it from the Microsoft website.

4th Generation Design

Product Notes

4G Easy

Beginning with the Teamcenter 11.2.2 release, the 4gd_populate_utility is replaced by the 4g_easy utility. You can use the new 4G Easy tool to interact with the utility. See the Teamcenter 4th Generation Design help for more information.
Chapter 6: Manufacturing (CAM)

Manufacturing Product Notes

The Manufacturing product notes describe product changes that are not included in the What’s New in NX documentation.
CAM Early Access program

Some of the new NX CAM features are available only upon request through the CAM Early Access Program. In order to learn more about these pre-release features, please contact GTAC. GTAC will forward your request to the appropriate development contact.

The early access features available in NX 12.0 include the following:

- **B-axis continuous turning**: The **Finish Turn** operation supports continuous tool axis orientation changes within one operation.

- **Multi-Tool**: A new tool assembly type defines tools consisting of multiple cutters. The tools can be used in multiple functions.
Tool path and template changes

Tool path changes

A general reminder: There are ongoing changes in the processors to fix problems, add enhancements, and improve reliability. In many cases, you may see some differences between the new path and the old path when you generate an operation from a previous release. If you rely on automatic methods, these changes should be acceptable. The end result of the new path should be comparable to, or better than, the previous path.

To prevent accidental changes to tool paths in part files from a previous release, use the Lock Tool Paths During Version Upgrade customer default. This option automatically locks all operations with an edit status of Complete or Repost.

CAM configuration changes

• No changes

Operation template sets

• No changes

Operation template parts

• In turning.prt:
  o Updated to fix the problem where turning Turn Orient WCS mapping of XC and YZ was not inherited. (NX 11.0.2)
  o Collision check includes the insert and holder for all methods.

• In hole_making.prt, added collision check and gouge check for Boss Milling and Boss Thread Milling operations.

Merging customized templates

You can merge your customized templates with the templates included in this release in the following ways:

• Start with the new default templates and apply your customizations. This is highly recommended to ensure you receive all the PR fixes.

• Re-file your customized templates in the new release, review the changes listed for the release, and implement the applicable ones in your templates. This method is not recommended, because you will not receive the PR fixes.
General changes

Paste with Reference enhancements

The Paste with Reference command now supports wave links and the new manual drilling operations.

2D Dynamic collision display when verifying a tool path

In previous releases, rapid tool motions through the Part, Blank or IPW were displayed in the red gouge color as material removed. In the current release, the material removal from these tool motions is not displayed, so you will not see these collisions. To check for collisions, do one of the following:

• Click List after the simulation stops.

• Click Collision Settings. In the Collision Settings dialog box, select the Pause on Collision check box to stop the visualization when a collision occurs. This option does not work if you step through the operation.

User Defined Operation and API Enhancements

The User Defined Operation API now has the ability to:

• Use the 3D milling IPW from a previous operation as the blank.

• Write level markers to the tool path. In verify, a tool path will have the ability to display one level at a time, just like a Cavity Milling operation.

Machine Tool changes

The standard machine tools supplied with NX have revised postprocessors and kinematics models. Review all existing Manufacturing setups which use a standard machine tool from a release prior to NX 8. If necessary, retrieve the machine tool again.
Integrated Simulation and Verification (ISV)

Installed machines and simulation samples

For information about how to use the standard installed machines and simulation samples included with NX, see the Working_with_OOTB_MACH_Simulation_Examples.pdf file in the mach\samples\nc_simulation_samples folder of your NX installation.

Postprocessors for installed machines

The NX 12 machine library includes setups with posts created using PostConfigurator and posts created using Post Builder. The Post Builder setups include the post units in their name. For example, sim01_mill_3x_sinumerik_in.

ISV Simulation

• If the spindle speed is zero for an operation, then no material is removed from the IPW.

• Internal and external simulations now use the same geometry definitions for the part and the workpiece. You must assign the geometry to the related kinematic model components, which are classified as _PART and _WORKPIECE.

If a legacy part does not have geometry defined in the kinematics model, NX uses the geometry defined in the Operation Navigator for internal simulations.

• External file simulation in Teamcenter Integration for NX uses the same file selection box as native NX.

• CSE simulation with the Sinumerik 840D controller has improved inch unit handling. When you use inch units:
  o The values inside the to_ini.ini file must also be in inches.

  o The variable values in the to_ini.ini file created by older Sinumerik posts must also be in inches. If they are not, use one of the standard posts provided with NX instead.

• The CSE Machine Configurator version 1.0.0.1027 supports file extensions. We recommend that you use the latest version of the Machine Configurator, because future CCF files shipped with NX will include file extensions.

• For the option Show Tool Path, NX determines which machine component to attach the tool path to in the following way:
  1. In the Operation Navigator, NX finds the part geometry of the current operation.

  2. In the kinematics model, NX looks for a machine component which has the part geometry attached.
   o If the part geometry is found, NX attaches the tool path to that machine component, regardless of its classification.

   o If the part geometry is not found, NX attaches the tool path to the first machine component classified as _PART.
• For the option Show Tool Trace, NX attaches the tool trace to the first machine component classified as _PART.

• Tool path based simulation without a machine tool supports turning tools only when the holder angle is zero.

  The machine tool node displays NULL_MACHINE or GENERIC_MACHINE when a machine is not loaded.

**Customizing the Simulation Control Panel dialog box Speed slider behavior**

If your simulation is too fast or too slow, you can change the Speed slider behavior by specifying a different Minimum Simulation Time value. For a faster simulation, you increase the Minimum Simulation Time value. For a slower simulation, decrease the Minimum Simulation Time value.

NX uses the following formula to calculate how often to display an update during simulation.

\[ \text{MST} \times 2^{(n-1)}, \text{ or } \text{MST} \times 2^{(n-1)} \]

where:

• n is the slider setting.

• MST is the Minimum Simulation Time setting from the Manufacturing setup or the library machine tool.

The longer the time between display updates, the faster the simulation. For example, if the tool path to simulate is 100 machining seconds long, and the display updates every 1 second of machining time, then NX must update the display 100 times for the simulation. If the display updates every 5 seconds of machining time, then NX updates the display 20 times for the same simulation, and the simulation runs faster.

**Note**

The MST value must be a multiple of the cycle time. If it is not, NX displays an alert and rounds the value to a multiple of the cycle time set on the General tab in the Machine Configurator (MCF) dialog box.

For VNCK simulations only, NX takes the cycle time directly from the booted VNCK and ignores the MCF entry.

In the following examples, the cycle time is 5 milliseconds (.005 seconds). The calculated value indicates how often NX updates the display.
MST = 0.005

• n = 1
  0.005 * 2^0 = 0.005 * 1
  = 0.005 seconds

• n = 2
  0.005 * 2^1 = 0.005 * 2
  = 0.01 seconds

• n = 3
  0.005 * 2^2 = 0.005 * 4
  = 0.02 seconds

• n = 10
  0.005 * 2^9 = 0.005 * 512
  = 2.56 seconds

MST = 0.01

• n = 1
  0.01 * 2^0 = 0.01 * 1
  = 0.01 seconds

• n = 2
  0.01 * 2^1 = 0.01 * 2
  = 0.02 seconds

• n = 3
  0.01 * 2^2 = 0.01 * 4
  = 0.04 seconds

• n = 10
  0.01 * 2^9 = 0.01 * 512
  = 5.12 seconds

MST = 0.05

• n = 1
  0.05 * 2^0 = 0.05 * 1
  = 0.05 seconds

• n = 2
  0.05 * 2^1 = 0.05 * 2
  = 0.1 seconds

• n = 3
  0.05 * 2^2 = 0.05 * 4
  = 0.2 seconds

• n = 10
  0.05 * 2^9 = 0.05 * 512
  = 25.6 seconds

If the MST stored with the library machine tool is different from the cycle time in the MCF, the simulation performance is now different after you retrieve the tool from the library. For example:

<table>
<thead>
<tr>
<th>Release</th>
<th>MST value in the machine tool</th>
<th>Cycle time from MCF (milliseconds)</th>
<th>MST value used for display update</th>
</tr>
</thead>
<tbody>
<tr>
<td>NX 10.0.3 MP5 and earlier</td>
<td>.01</td>
<td>5</td>
<td>0.005</td>
</tr>
<tr>
<td>NX 10.0.3 MP6 and later</td>
<td>.01</td>
<td>5</td>
<td>0.01</td>
</tr>
<tr>
<td>NX 11 and later</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**ISV using CSE simulated controllers with Python parser**

• The CSE Python parser is supported for Windows only.

  This means that the standard examples supplied with NX will not run on non-Windows operating systems. As a workaround: Inside the Machine Configurator, in the **Global Settings** dialog box, change the **Implementation** setting for the MCF from **Python** to **Library**.

• For existing simulations using Python parser with encrypted files from older versions, for example NX 9 or NX 10, we recommend that you use the un-encrypted *.py files from the latest release.

**Virtual NC Kernel (VNCK)**

To run an external file machine tool simulation properly, all channels of the machine tool model that can be assigned a main program must exist in the kinematics model before you start VNCK.
Active Tool

In Verify and tool path based simulation, the active tool is always the one that is associated with the current operation in the Machine Tool view of the Operation Navigator.

In CSE simulation, you can have multiple tools active for each channel.

- You activate the tool for a channel using the AnyController command `activateNextTool()`.
- There is one active tool per turret or spindle carrier. The total number of active tools is limited by the number of carriers.
- For material removal, NX takes every active tool in the channel of the current motion into account.
- For gouge check, NX only considers the last active tool in a channel.
Turning

Threading operations

When you machine conical threads with multiple starts, the engage and retract behavior is different. This is because NX now calculates the pitch distance of conical threads along the centerline of the cone. In versions prior to NX 11, NX calculated this distance parallel to the surface of the cone.
Hole machining

Feeds and Speeds - Set Machining Data

For a step drill tool, NX calculates the spindle speed based on the tip diameter.

Back Counter Sinking operation

The collision check fails if you do not use a pre-drill operation, or when the pre-drilled hole is too small. This is because the spindle is in non-spinning mode when it moves through the hole, and non-spinning tools do not report collisions.
Feature-based Machining (FBM)

Feature teaching no longer supports the **Inferred** CSYS subtype.
Manufacturing critical maintenance and retirement notices

Manufacturing Wizard Builder

The Manufacturing Wizard Builder is on critical maintenance. It is a plug-in for the Process Studio Author (PSTUDIO) application, which is no longer being developed. The 32 bit version is included in the NX installation, and there is no plan to discontinue this.

The location in the Windows start menu has changed. Choose Start→All Programs→Siemens NX 9.0→Manufacturing→Process Studio Author

There are no plans to discontinue CAM Wizards, which are xml files based on our block based UI architecture.

Point To Point planned retirement from all platforms

Point To Point is in critical maintenance. The Drill template has been hidden by default, but is still available.

The following operations and geometry objects in the Drill template are affected:

• DRILL_GEOM
• SPOT_FACING
• SPOT_DRILLING
• DRILLING
• PECK_DRILLING
• BREAKCHIP_DRILLING
• BORING
• REAMING
• COUNTERBORING
• COUNTERSINKING
• TAPPING

The hole drilling operation introduced in NX 9 should be used instead of the Point To Point module. The new method to manually drill holes will fully replace the Point To Point module over the course of the next one to two releases.

The migration of Point To Point operations is not committed at this time, but will be considered for a future release.

The new method to manually drill holes not only replaces the Point To Point module, but it also includes new capabilities such as:

• Sequential Drilling
• Deep Hole Drilling

• Back Countersinking

• Hole Chamfer Milling

• Hole Milling and Boss Milling

• Thread Milling and Boss Thread Milling

• Radial Groove Milling
Manufacturing caveats

General caveats

NX process

When you exit NX, it may close the UI without stopping the process. There is no data on how widespread this problem is.

Work Instructions

Do not include Documentation operations as the target for the following commands, as unexpected results may occur.

- Parallel Generate
- Replay
- Object Transform
- Simulate
- Gouge Check
- Verify

Shop Documentation

Each time you create Shop Documentation, NX generates facet bodies. To reduce the size of your part file, delete the facet bodies before saving it.

Command Finder: Faceting

Tilt Tool Axis

<table>
<thead>
<tr>
<th>Problem</th>
<th>Workaround</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shortest 2D distance to curve</td>
<td>Use the 3D shortest distance option.</td>
</tr>
<tr>
<td>For longer tool paths, the shortest distance calculation can become unsynchronized.</td>
<td></td>
</tr>
<tr>
<td>The tilted tool path may have non cutting moves with lifts in regions where they are not needed, and the moves can cause gouges.</td>
<td>None</td>
</tr>
</tbody>
</table>

IPW

- A Generic Motion (GMC) operation does not change the machine mode state of the IPW. Adding a Machine Control subop with a Set Modes event at the beginning of the GMC operation does not change the machine mode state of the IPW. The previous machine mode, either milling or turning, remains active.

  If the preceding operation does not have the required machine mode, you must add an operation with the required machine mode before the Generic Motion operation. For example, if the
Generic Motion operation is for turning, add a turning operation. The new operation must generate tool path, but does not need to cut material.

**Note**

This is not a limitation in ISV when you use the CSE driver. The machine state is defined by the workpiece spindle setting, which is either turning or milling.

- The IPW calculation is inconsistent:
  - For **Verify** and **Simulate**, rapid motions do not remove material.
  - When you generate the tool path for operations using the IPW, rapid motions can remove material.

  This difference can result in unexpected results, for example when you use **Show 3D IPW**.
**Milling caveats**

**Adaptive Milling**

- Mill Area is not included in the template parts, and is not supported. You must use trim boundaries to contain the cut areas.

- Bull nose tools are not supported completely. NX checks for a corner radius on tools and outputs a warning. Adaptive Milling may leave material when the corner radius of the tool is larger than 10% of the tool diameter.

**Interpolate Vector tool axis option**

The locations of the points are sensitive to drive method settings, and changes to cut direction, cut pattern, and cut area may relocate vectors defined earlier. Make sure you check the vectors after modifying the drive settings.

**Area milling drive method operations using trim boundaries**

The **Contact** tool position option for trim boundaries trims the tool path to the tool contact of the trim boundary. However, with the **Extend at Edges** cutting parameters option selected, the tool is moved past the contact by the specified extend distance. In the past trim boundaries were not changed by the **Extend at Edges** option.

[Area milling drive method operation]→**Cutting Parameters**→**Strategy** tab→**Extend Path** group

**Curve/Point drive method — Offset Left option**

The loops caused by offsetting a concave curve or curves are not trimmed.

**Rotary Floor milling**

<table>
<thead>
<tr>
<th>Problem</th>
<th>Workaround</th>
</tr>
</thead>
<tbody>
<tr>
<td>The <strong>Min. Lead Angle</strong> does not influence the tool path.</td>
<td>None</td>
</tr>
</tbody>
</table>
| When you use sheet geometry to define a concave floor, sometimes the default material side is wrong and no tool path is produced. | 1. In the **Rotary Floor Finish Drive Method** dialog box, in the **Drive Geometry** group, click **Flip Material**.  
2. Generate the operation. |

**Fixed-axis contouring cut area selection**

<table>
<thead>
<tr>
<th>Problem</th>
<th>Workaround</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Problem</strong></td>
<td><strong>Workaround</strong></td>
</tr>
<tr>
<td>-------------</td>
<td>----------------</td>
</tr>
</tbody>
</table>
| When you edit a cut area created with the selection method set to **Edge Bounded Region**, the seed face and the bounding edges display in the selection color and are difficult to identify. | You can use the alternate selection color to identify the seed face and bounding edges.  
- To see the seed face, click **Select Bounding Edges**.  
- To see the bounding edges, click **Select Seed Face**. |

**Tip**

If you still cannot see the bounding edges, increase the line width display.

Menu→Preferences→Visualization→Visualization Preferences dialog box→Line tab→Part Settings group→Show Widths → set Width Scale to Maximum
## Contour Profile variable axis profiling

<table>
<thead>
<tr>
<th>Problem</th>
<th>Workaround</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Contour Profile</strong> operations only compensate for diminishing walls when the wall is in contact with the floor.</td>
<td>None</td>
</tr>
<tr>
<td>Supported cases:</td>
<td></td>
</tr>
<tr>
<td>Not supported cases:</td>
<td></td>
</tr>
<tr>
<td>Multiple offset passes that push the tool entirely above the wall height significantly increase generation time.</td>
<td>To reduce generation time, limit the number of offsets so that they do not exceed the wall height.</td>
</tr>
</tbody>
</table>
**Hole machining caveats**

**Tapping operations**

Drilling 🔄 and Tapping 🛠️ are distinct operation subtypes. Although tapping cycles are available in the Drilling operation dialog box, we recommend that you do not use a Drilling operation combined with a tapping cycle. The tapping cycles will be removed from the Drilling operation in a future release.

In a Tapping operation, you can set feature geometry parameters, such as pitch, that output the required mom variables for tapping. If you use one of the tapping cycles in a Drilling operation:

- The operation will not contain the necessary feature geometry parameters and in-process feature volumes for tapping.
- You will have the legacy Point to Point output where the pitch is driven by feed rate.

**Back Counter Sinking operation**

The Gouge Checking option reports false gouges.
ISV caveats

HMI Advanced

- HMI Advanced is always positioned in the top left corner of the Windows desktop. You cannot move it from there.
- HMI Advanced is always on top of all other applications.
- Starting HMI Advanced resets Windows colors to a specific HMI Advanced color schema.

Additional restrictions:
- Windows 10 is not supported.
- If you are running one VNCK with HMI Advanced simulation and try to boot another VNCK with HMI Advanced, the second attempt will fail. VNCK will crash and NX cannot finish the initialization of the CSE.

Visualize 2D Dynamic

- If blank geometry is not defined, you must click Step Forward twice before NX asks for blank geometry.
- On the Linux and Mac OS X platforms, the 2D Dynamic tab may not be active.
  The 8-bit PseudoColor visual graphics driver mode is not supported. As a work around, change the graphics X server settings. For example:
  NVidia Quadro and FX graphics drivers
  In the XF86Config file, in the Device section, set ClOverlay to TRUE.

Simulation

- In certain cases the reported minimum distance of a clearance violation is not the closest distance.
- Selecting a location on the tool path is now supported in ISV for both CSE-based simulation and tool path simulation. Selecting tool path segments involving cycles, such as drilling cycles, may not work in some cases.
  There are also some cases in which the selected positions of rapid motions are not displayed correctly.
- When the simulation runs in the history buffer, and the spindle speed Output Mode for an operation is set to SFM or SMM to maintain constant surface speed, the simulation behavior can be unreliable.

CSE simulation

- In the new Program Manager dialog box, you must start Machine Code Simulation before you can use the Check Syntax command.
- When there are multiple workpiece objects, the tool trace is always attached to the first component classified as _WORKPIECE, and moves with the component. If the tool trace is
displayed on the wrong component, you can reorder the kinematics tree to place the required _WORKPIECE component first.

The position of the tool trace is relative to the active tool, as that tool is defined in the CSE driver.

**Virtual NC Kernel (VNCK)**

- In the **Machine Axis** dialog box, on the **Advanced** tab, the WCS values are always the same as the MCS values.

- Displaying the CSE variables can influence performance. As a best practice, either limit the number of variables to approximately five, or use the controller panel of the Sinumerik controller to check the status of NC variables.

- Do not use the **Fast Reset** command; it can cause an internal error. As a workaround, use the **Full Reset** command.

- When it reaches a breakpoint, the simulation may fail to stop or may not stop at the exact position specified.

- When multiple working versions of VNCK with HMI Advanced are installed on a computer, you can only run one version at a time.

**Positional ISV — Show Machine Axis Positions dialog box**

- If you are running VNCK, the WCS is always the same as the MCS.

- When the setup has a multi-function machine and you use the dynamic manipulator to change the tool axis for a fixed-axis operation, NX does not update the **Show Machine Axis Positions** dialog box. To avoid confusion, use the **Show Machine Axis Positions** customer default to suppress the dialog box.

1. Choose **File** → **Utilities** → **Customer Defaults**.

2. In the **Customer Defaults** dialog box, choose **Manufacturing** → **User Interface**.

3. Click the **Dialog Boxes** tab, and in the **Visibility** group, clear the **Show Machine Axis Positions Dialog** check box.

**Program Manager**

Adding or importing a program file without a file extension can cause problems. Make sure the files you import have a file extension. As a best practice, always use the file extension defined in Machine Configurator. The default **CCF** files include file extensions.

**Generate IPW with Path customer default**

Using the **Generate IPW with Path** customer default may cause commands that require the IPW, such as **Verify**, to have problems when the IPW is not complete. This can happen because the IPW takes more time to generate than the operation.
Post Configurator

DEF File Editor
The editor removes comments from the main definition file, including any existing comments.

Synchronization Manager
You cannot reorder operations within Synchronization Manager for a post created by Post Configurator. You must order the operations in the Program Order view before entering Synchronization Manager.

Heidenhain MillTurn support
MillTurn operations are not postprocessed correctly for Heidenhain controllers when you create the postprocessor with Post Configurator.
Workaround: None.

Canned Cycles
The drilling depth output is wrong if the depth is deeper than 99 mm.

Output of spindle orientation for back bore operation
The spindle orientation might be wrong in some situations.

UDE Rotate
The postprocessor might crash in some cases when you add UDE Rotate to the operation.

TCPM prepositioning plane
When this option is activated, the plane output for the prepositioning is wrong in the following case:
• There is only one MCS in the Geometry View of the Operation Navigator, and
• The MCS is defined as Local, and
• Special Output is set to None.
Feature based machining caveats

Teach Feature Mapping, Teach Operation Sets

Limitations and workarounds:

<table>
<thead>
<tr>
<th>When you</th>
<th>Teach Operation Sets does not use</th>
<th>Workaround</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run Teamcenter Integration for NX, and store the operation templates in Teamcenter</td>
<td>The correct operation subtypes</td>
<td>• Manually add the missing tool classes and operation subtypes to the generated machining rules using the Machining Knowledge Editor.</td>
</tr>
<tr>
<td>Use a library other than the native ASCII library, such as MRL or TDM</td>
<td>The tool class</td>
<td>• Replace the missing subtypes and classes. To do this:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1. (Optional) Change your CAM configuration to use native operation types and the standard ASCII tool library.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2. Use Teach Operation Sets to teach the operations.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3. Use the Machining Knowledge Editor to add or optionally replace the tool classes and the operation subtypes.</td>
</tr>
</tbody>
</table>

Line Designer

Product notes

Template files

The standard part files delivered with Line Designer must be imported into the Teamcenter database to ensure that they are available in the New Item dialog box. If this step is not performed, the New Item dialog box displays only blank templates.

A setup script for installing Line Designer templates in Teamcenter is included with NX:

%UGII_BASE_DIR%MANUFACTURING_PLANNING\templates\tcin_linedesigner_template_setup.bat

For information about how to use the script, see Installing File New templates in the NX help at the following location:
Platform support

Line Designer is currently supported only on Windows platform.

Data Upgrade

Due to changes in the connector design in NX 11, equipment that uses connectors created before NX 11 must be upgraded to NX 11 or later format. To do this, we recommend that you open and save the equipment in NX 11 or later.

Equipment that uses connectors created in NX 11 is upgraded automatically in NX 12.

For more information, see Using library components with connectors from NX 11 or earlier in the Line Designer caveats.

4GD support

Use of Line Designer with 4GD capabilities requires a Teamcenter extension called 4GD Plant Design. Migrating from the FactoryCAD to the Line Designer library also requires a Teamcenter extension, included in the Manufacturing Additions package to Teamcenter installation (ManufacturingAdditions 2.1). You can get the Manufacturing for 4GD package from the download section of the Siemens PLM Software download server.

From the left side list of the product categories, choose Teamcenter and Teamcenter Rapid Start.

The Windows package is located at the following location:

- Teamcenter and Teamcenter Rapid Start → Full Products → Integrations and Solutions → ManufacturingAdditions → 2.1 →
  - TC10.x_ManufacturingAdditions_2.1_wntx64.zip / TC11.x_ManufacturingAdditions_2.1_wntx64.zip

The Linux package is located at the following location:

- Teamcenter and Teamcenter Rapid Start → Full Products → Integrations and Solutions → ManufacturingAdditions → 2.1 →
  - TC10.x_ManufacturingAdditions_2.1_lnx64.zip / TC11.x_ManufacturingAdditions_2.1_lnx64.zip

Instructions for applying the Manufacturing Plant extensions are included in the package zip file (Plant Extensions - Deployment Guide.pdf).
**Factory resource samples**

Installation of the sample factory resources, conveyors, and robots from the manufacturing resource sample library to Teamcenter is highly recommended.

- **Factory Resources**
- **Factory Conveyors**
- **Factory Robots**

Instructions for installing the samples are located in the following section of the Teamcenter HTML documentation:

- Home→
  - Installing→
    - Installation on Windows Servers Guide→
      - Adding Features→
        - Manufacturing→
          - Installing and configuring the Manufacturing Resource Library

**Manufacturing Resource Library version compatibility**

For Teamcenter 10.1.7 or Teamcenter 11.2.3, Line Designer in NX 12 supports the use of factory resources from the Manufacturing Resource Library (MRL) 3.1.7 or later.

For Teamcenter 11.3, Line Designer in NX 12 supports the use of factory resources from the Manufacturing Resource Library (MRL) 4.0.

You should always upgrade the Manufacturing Resource Library components from the previous release to the new release.

**Upgrading smart objects to the current NX version**

NX will automatically upgrade the older version of smart objects from previous NX releases to the new version when they are opened and saved in new version of NX.
Documentation notes

Note the following about the Line Designer documentation:

- Line Designer can work with either BVR or 4GD data structures, and the documentation describes BVR and 4GD procedures separately wherever required.
  
  In the release notes, you can find Line Designer in the CAM section.
Caveats

Configured components in the Plant Navigator

Configured out components from the plant structure appear as loaded components with no graphics in the Plant Navigator.

Using library components with connectors from NX 11 or earlier

While placing or disconnecting components in a layout, or while dragging components to another layout, you may experience incorrect behavior if those components have connectors created in NX 11 or earlier.

Recommendation Before using the library objects in NX 12 Line Designer layouts, you should upgrade any part files of the library objects that include connectors created in NX 11 or earlier. To do this, open and save the library objects.

Show Occurrence Name

In a layout, when you use a component created in NX 11.0.2 or earlier, NX does not show a value in the Occurrence Name column for that component.

Workaround Remove the Occurrence Name column using Column Configuration, and close NX.

Restart NX, open the layout again, and add the Occurrence Name column.

Note

You need to perform the above workaround only once for the components with an Occurrence Name issue.

Note

This behavior does not appear for components migrated from NX 11.0.2 to NX 12.

Editing smart components in a layout

In a layout, when you edit a floor component or a platform component from the Reuse Library, the geometry of that component disappears.

Workaround Change the reference set of that component, from Model to Entire Part.

CMM Inspection Programming

CMM release notes

NX 12 enhancements

NX CMM delivers major enhancements at point releases. NX 12 primarily contains enhancements from NX 11.0.1 and 11.0.2, and. For these enhancements, see the following link:
Title not found

In addition:

- There is now a standard PC-DMIS Post.

- There is a new collision avoidance option, *Delete User Inserted Safe Points*.
  
  Turn this option off to retain safe points such as manually inserted safe moves, or entry and exit points.

**PAX file change**

The .pax files are now located in the *UGII_BASE_DIR\cmm_inspection\templates* folder.

**VALISYS critical maintenance and retirement notice**

The VALISYS application is unsupported as of July 21, 2016. Use the NX CMM Inspection Programming application instead of VALISYS Programming and use CMM Inspection Execution instead of NX-Inspect.

**Linking to PMI information**

All geometry referenced by PMI must be in the current reference set, and if it is not, then NX:

- Issues warning messages in the information window.

- May still create features, but will not create paths because there is no access to the feature geometry.
Caveats

Renaming or deleting the SENSORS group

In the Inspection Navigator, do not delete or rename the SENSORS group as this may cause machine simulations within the Inspection Path dialog box to fail.

Machine simulation

When you create an inspection path or simulate a program, you may see the following INI Programs message:

In order to handle INI files in the Program Manager, define the channels in the Machine Tool Builder.

You can ignore this message for NX CMM Inspection applications. It has no effect on the machine simulation.
Chapter 7: Simcenter (CAE)
Simcenter supported platforms

For information about operating system platforms supported by Simcenter, see Operating system requirements.

Note
Simcenter does not support the Mac OS X.

Pre/Post

Caveats

Universal Connections

• (PR 8993464) The software currently issues an error message when you play a recorded journal file that contains a Bolt Connection type of Universal Connection that uses CBAR and RBE2 type elements. The software does not issue an error message when you play a recorded journal file that contains a Bolt Connection that uses only RBE2 type elements.

• (PR 8994319) The software currently issues an error message when you play a recorded journal file in which a Bolt Connection type of Universal Connection is deleted and then recreated using the Undo command.

Load recipes

(PR 8345475) Simcenter currently crashes with a memory access violation when you export a solution that includes loads that reference a Load Recipe and the software cannot access the Load Recipe that contains the load data. This can occur, for example, if the file that contains the load values is moved manually, or when a Simulation file is copied to a workstation that cannot access the original data source file.

Materials

• The Test Condition Parameter and Endurance Limit properties, and the Stress-Life Data option Slope Field on the Durability page in the Isotropic Material dialog box are currently unsupported. They are used by a new durability solution that will be available in a future release.

• The Stress-Life Data option Field prior to Simcenter 12 is renamed to Fatigue Life-Stress Field to better distinguish between the options in the current and the future durability solutions.

NX Nastran FEM Acoustics and Simcenter Acoustics BEM

• In Indirect Vibro-Acoustic analyses, your model cannot contain isolated structural nodes (nodes that are not attached to any elements).

• (PR 8991440) NX Nastran computes the area correction factor (K) for transfer admittance when the AREA field on the ACTRAD bulk data entry is set to 0. However, in the Transfer Admittance dialog box in Pre/Post, the area Correction Factor (K) option, which corresponds to the AREA
field, does not accept a value of 0.0. To work around this issue, you must write out the NX Nastran input file and edit the ACTRAD entry to specify a value of 0 for the AREA field.

- To use either the Fast Multipole or the H-Matrix solution methods (available with the Simcenter Acoustics BEM environment in an Indirect Acoustic analysis), you must have the Microsoft Visual Studio 2008 dll redistributable installed, which is not currently part of the standard Simcenter installation.

- (PR 8944307) In the Simcenter Acoustics BEM environment, the software does not prevent a symmetry plane from cutting through the BEM model mesh, nor does it issue a warning message. The Fast Multipole solver fails when the model includes a symmetry plane through the BEM model mesh.

- In the Simcenter Acoustics BEM environment, neither the Fast Multipole nor the H-Matrix solution methods currently compute acoustic power.

- (PR 7936548) In the Simcenter Acoustics BEM environment, both the Fast Multipole and H-Matrix solvers fail if the name of the solver input file contains a space. To avoid this issue, do not include spaces in the names of input files or any associated directories.

- In the Simcenter Acoustics BEM environment, Simcenter does not validate the frequency range that you specify for the Fast Multipole solver, which has requirements for both the maximum-allowed frequency and the minimum-allowed frequency.

- (PR 8972329) In the Simcenter Acoustics BEM environment, the H-Matrix solver fails on the Linux platform when you use the Number of Threads per Process option in the Solver Parameters dialog box to specify processing on multiple threads. To work around this issue, use a single-thread process.

**Post Processing**

- (PR 8995564) When you have a multiple viewport layout, you cannot use the Post Processing Navigator to create a 3D post view in a viewport that contains a 2D plot that you created with the Scenario Setup command. To work around this issue, first use the Return to Model command.

- (PR 8351231) When you plot Rotation, Angular Velocity, and Angular Acceleration in 3D Post Views with scenario-based post processing, values that are in degrees are incorrectly reported to be in radians. This will be fixed in SC12.0.0 MP1.

**Abaqus environment**

Currently, you cannot import degenerate hexahedral elements into the Abaqus environment. A degenerate hex element has four nodes that have the same labels, so it becomes a pyramid element. This limitation will be addressed in a future release.

**ANSYS environment**

- (PR 8957875) When your FEM file contains cohesive elements, the software does not properly validate SOLID272 and SOLID273 elements, and a warning message displays when you exit the Physical Property Table dialog box. If your FEM file does not contain cohesive elements, then the software correctly validates any SOLID272 and SOLID273 elements.
• (PR 8936597) Performance and memory issues may occur when you export a large number of table fields, especially when the same table field is referenced by many different load steps. The software may hang or export incorrect results. To workaround this issue in a transient analysis, create a table field with a single time table that covers all steps, and then reference this table field in the first step only.

Nastran environment

In the SOL 402 Multi-Step Nonlinear Kinematics solution:

• The Reference Displacement (REFE) parameter on the Equilibrium Iteration and Convergence page in the Nonlinear Control Parameters modeling object is misspelled: it actually refers to an energy value (J) as its units suggest, not a displacement length.

• (PR 8351722) If you set Restart Computation Flag (RSUB)=n in the following types of subcases, the subcase must immediately follow subcase n. If subcase n does not immediately precede the subcase that calls it, the end state of subcase n is not used, and no warning or error message is written to the output file.
  o Subcase - Normal Modes
  o Subcase - Cyclic Modes
  o Subcase - Axisymmetric Fourier Modes
  o Subcase - Buckling

The Restart Computation Flag (RSUB) parameter is located in the Nonlinear Control Parameters - Subcase dialog box, on the Restart Options page.

• (PR 8351714) There is a known issue with damage results when the software associates a Damage Interface (MATDMP) material with PSOLID elements. In the OMATMPFD datablock identification, the type of law is erroneously set to 0 instead of 1 or 2. The software issues a warning message at the end of the .f06 file that indicates that Simcenter cannot properly display the damage results.

• (PR 8351716) Nodes from CELAS elements that do not belong to structural elements have no results when you solve a Subcase - Normal Modes step.

• (PR 8351718) In the Contact Parameters - Multi-Step Nonlinear Pair dialog box (BCTPAR2), the software ignores the specified Constant Gap Distance (GAPVAL) value when the Initial Penetrations/Gaps (INIPENE) option is set to Overridden by GAPVAL.

• (PR 8351719) Tensor results on deformed elements may not display well in Simcenter. This problem occurs because the content of the TRMBC/TRMBU datablocks, which allow the software to orient results on deformed elements, must be corrected.

• (PR 8351720) In Subcase - Cyclic Modes steps, the norm of eigenvectors must be corrected when you include a Real Eigenvalue - Lanczos (EIGRL) modeling object and select MASS from the Method for Normalizing Eigenvectors list.
• (PR 8351721) For solid elements, the software currently uses the wrong convention to write non-diagonal components of strain tensors other than total strain. The software currently uses epsilon (ε) instead of gamma (γ).

• (PR 8351723) The software currently writes the ply thermal strain data block twice in the .op2 file for multilayer shell elements.

• (PR 8351724) Stress results may be missing from Subcase - Normal Modes steps if the model contains composite elements.

• (PR 8352952) In a contact analysis that uses 3D elements, when you select SEPDIS from the Separation and Slide Distance list (Contact Result page in the Structural Output Requests dialog box), the software does not correctly calculate the total contact sliding distance and reports a value of 0. Additionally, in a contact analysis that uses 2D plane strain elements, the software does not reset the total contact sliding distance value when the contact is lost.

Simcenter Multiphysics

(PR 8348161) When your solution includes a Deactivation Set Advanced simulation object, Pre/Post correctly skips the deactivated elements when you export the NX Nastran input file. However, Pre/Post may also skip other entities that reference the deactivated elements, such as other simulation objects and loads. When this occurs, the software issues a warning message that notes that the entities were skipped because of subset export specifications.

Samcef environment

• The following issues currently occur when you import a Samcef model in Simcenter:
  o (PR 7968311) BORNES bounds of analytical .FCT functions are ignored during the import and a default BORNES 0 1 parameter is written in the Samcef deck file when you export the model again.
  o (PR 7969581) During the import, unused .FCT functions are written in the User-Defined Text epilog. However, they keep their original numbering that can interfere with the functions output when you export the model again.
  o (PR 8970053) The import of .FCT functions with a "&" (ampersand) in their names fails.
  o (PR 8983412) When importing a multilayered 2D structural model, the Tolerance Angle property is not taken into account and the import fails to group composite data.
  o (PR 8974666) Eccentricities in Axisymmetric and Other 2D Structural models are not imported.
  o (PR 8969886) 2D plane strain quadrangular elements are not imported.
  o (PR 8969095) Coordinate systems (.FRAME commands) of the cylindrical type are not imported.
  o (PR 8968057) Constraints related to the non-uniform torsion in Samcef beams (.CLM FIX COMP 8) are not imported.
  o (PR 8967996) Beam non-structural masses (.PHM LMAS commands) are not imported.
Chapter 7: Simcenter (CAE)

- (PR 8973539) 2D multilayered element non-structural masses (.PHP SMAS commands) are not imported.
- (PR 7978558) Manual coupling conditions (.LIA commands) in which coupling directions (.FRAME commands) have been defined on both the independent and dependent nodes are not imported.
- (PR 7977385) The import of fixed temperature loads (.CLM TFX commands) fails if the Input File Units import units system is set to Kelvin for the temperature, while the imported Samcef model temperatures refer to Celsius values.
- (PR 8350113) Radiation conditions attached to .PRIT glue commands are not imported.
- (PR 8970178) Multilayered parabolic hexahedral elements are not imported.
- (PR 8350449) The import of a time dependent structural accelerations load fails if each component of the acceleration load refers to a different time dependent .FCT function.
- Samcef commands that are not imported are written in the User-Defined Text epilog. These commands may refer to function ids that are imported in Simcenter, for instance because these functions are also used in imported data. However, when you export the model again, these functions may receive a different id in the Samcef deck file, so that the reference stored in the epilog may not point to any existing valid function.
- If you import a model with 2nd degree Heterosis shells and if that model contains .MCT contact conditions, Heterosis extra nodes (aka 9th nodes) that are automatically created by Bacon for the contact condition are by default imported instead of being discarded. You can remove these extra nodes by selecting the Remove Orphan Nodes option in the import dialog box.

• The following issues currently occur when you export a Samcef model from Simcenter:
  - (PR 8350336) Samcef RIGA rigid body elements are badly exported if you specify a properties orientation CSYS.
  - (PR 8931960) In the Solution Step properties of a Thermal analysis type, the unit of the Maximum Temperature Variation (.SUB PRED) property is incorrect.
  - (PR 8952434) A composite criteria Output Requests of the tensor type (for instance the Samcef 6-components 9637 Puck criteria) are not output with the correct number of components it requires.
  - (PR 8349379) The export of a Convection thermal constraint that is defined with a 4D Field can take an unusually long time.
  - (PR 8349784) The nodal Force is badly exported if you set a cylindrical coordinate system for the load.
  - (PR 8983073) The orientation of the Pressure load on axisymmetric elements edges is badly exported.

• The following issues currently when you post-process Samcef results:
- (PR 7904954) When you import a Samcef axisymmetric model and its results, the axis of rotation displayed in the post view is wrong.

- (PR 8951359) The third component of the bush element results are displayed as Moment-Z while they must be Force-Z.

- Other issues:
  - (PR 7744998) On Linux operating systems, the Solution Monitor is refreshed every 10 seconds (instead of every second on Windows platforms). You must wait during the refreshing cycle to view the information on the new tab you selected.
  - (PR 8945166) When editing the representation of a large Samcef superelement, Samcef can run out of memory when checking the superelement and a File is invalid error message is issued.
  - (PR 8962030) During a Modal Analysis run, the Solution Monitor no longer displays the effective masses table.

**Simcenter Thermal/Flow, Space Systems Thermal, and Electronic Systems Cooling**

**Durability**
- Durability static events do not recognize combined loadcases.
- Durability static events do not recognize companion results.

- The Durability solution process does not support stress-life data defined using Slope Field for isotropic materials.

- The Durability solution process does not support stress-life data and strain-life data defined using Field for orthotropic materials.

- Surface elements connected to RBE elements are ignored in Durability solution processes.

**Laminate Composites**
- The new woven material model is available only in the NX Nastran and Multiphysics solver environments.

- It is not possible to export laminates or layups containing plies with Samcef curing materials.

- Equivalent laminate orthotropic thermal expansion coefficients are incorrectly calculated.

- Importing .layup files created on Windows platforms may fail due to carriage return characters.

  Workaround: open the file in a text editor, and replace the ‘CR-LF’ characters by ‘LF’ characters, for example in Notepad++, change \n\n to \n.

- When you export the laminate spreadsheet report to a Microsoft Excel spreadsheet, the spreadsheet is limited to 30 tabs.

  Workaround: export to a .csv file.
• 3D inflation may produce unexpected results when global ply butt joints are defined.

• 3D extrusion does not recognize cutting faces that are defined on both sides of the extrusion surface. Only those faces in the positive normal direction are considered.

• Simcenter Laminate Composites 2D implementation of the Hill failure theory differs from NX Nastran. The conditions related to the denominator of the cross-term differ.

• The Sandwich Inflation option in the Laminate 2D-to-3D Extrusion does not work.

**FE Model Correlation**

Regardless of the nodal displacement coordinate systems defined in the test universal file, test shapes (dataset 55) are always imported in the global coordinate system. This behavior is consistent with .unv files created in I-DEAS. However, files from Test.Lab and other systems must have nodes and mode shapes consistently defined in the global coordinate system.

**Test.Lab files (.lms)**

If you want to import Test.Lab files into load recipes, or if you want to use Test.Lab results as Mode Sets or FRF Sets, you must have the following installed on the same computer as Simcenter:

• LMS Test.Lab 15A or 16A, 64-bit versions only

• Active Pictures, which is the read-only version of Test.Lab.

If Active Pictures is not already installed, contact technical support (GTAC) for information on how to download it. Active Pictures does not require a license.

**Shape optimization and topology optimization**

• The documentation for Tosca-based shape optimization and topology optimization has been removed from the help. Topology optimization is now handled with NX Nastran SOL 200 Topology Optimization.

• All topologically optimizable elements in the design optimization area must use an isotropic material defined with a MAT1 bulk data entry. The model can include topologically optimizable elements that use other materials, but these must be excluded from the design area or frozen within the design area. Otherwise, problems might occur during the optimization process. Any elements that are not topologically optimizable may also use other materials, regardless of whether they are in the design area.

• For a SOL 200 Topology Optimization solution, if you create a checker boarding control (CHBC) manufacturing constraint, a Checker Board Radius box appears in the Manufacturing Constraint dialog box. However, this field does not operate as described in the documentation. When a radius value is omitted or set to zero or any positive value, NX Nastran automatically averages the material density values of adjacent elements, which is the default behavior that occurs if no CHBC constraint is created.

To allow checker boarding to occur (that is, to disable the checker boarding control in NX Nastran), set the radius to a negative value.

The Checker Board Radius field is equivalent to the OFF-FLAG field in the NX Nastran DMNCON bulk entry.
Flexible Pipe

- In the **Settings** dialog box:
  - On the **Allowables** tab, the default value for the **Minimum value for contact success** option is incorrectly set to 9000%. The correct default value is 90%.
  - On the **Database** tab, you do not need to specify a path for the **Optimization Result Database** option.

- While you can undo the creation of Flexible Pipe features, you cannot redo them.

- To access a subpanel from a tree item in any definition panel, you must double-click rather than press the **Enter** key.

- To close a subpanel of a definition panel, you must click the **OK** or **Cancel** button. You cannot press the **Enter** key to close a subpanel.

- Values expressed in coefficients per unit length are displayed with an incorrect character (mm#).
Documentation notes

Bounding Volume Mesh Controls

The Bounding Volume type of Mesh Control is honored only by meshes that you create with the 3D Tetrahedral Mesh command. 2D surface meshes and meshes that you create with the 3D Swept Mesh command do not recognize Bounding Volume mesh controls. Because of this, if a Bounding Volume mesh control is associated with a Bounding Volume type of selection recipe that lies very close to or intersects a surface of a 3D meshed body, the mesh may fail. In this type of situation, you can combine a Bounding Volume mesh control on a body with Size on Face or Point types of mesh controls on the faces of the body to improve the results.

Face from Mesh

The enhanced Face from Mesh operation that identifies and creates multiple faces can take only 2D meshes as input; it cannot take a 3D mesh as input and automatically extract the 3D element free faces. If you want to use the Face from Mesh command with a 3D mesh, you must first use the Surface Mesh command to create a surface coat mesh on the 3D mesh. You can then use the Face from Mesh command to generate a face from the surface coat mesh.

Motion

Caveats

The following issues currently exist in Simcenter Motion.

Road visualization

If you enable visualization for an RSM2000 file and use a small grid density (such as 10 mm), you might experience performance issues.

Model definition files

- When solving outside of Simcenter, externally modified expressions in MDF files are not evaluated.
- User-defined forces and gear contacts are not supported.
- Models with a speed-sweep element do not solve.

Submechanisms

- The following functionality does not support submechanisms:
  - RecurDyn solver
  - Adams/Solver
  - JT export
  - PLMXML import/export
o Capture arrangements linked from a submechanism
o Create sequence to master parts and create explosion to master parts linked from a submechanism
o Update design position
o Change reference set
o Import from subassembly
o Teamcenter 4GD
o Partial loading
o Referencing a flexible link or spline beam from a submechanism

• You cannot copy bushing, tire property, spline beam property, or analytical contact property parameters from a submechanism.

• (PR 8346978) Deleting an assembly constraint in the Assembly Navigator does not delete the associated submechanism positioner in the Motion Navigator. You must manually delete the positioner.

General

Plot graphs in AFU tables have a 112-character limitation for the record name.
Documentation notes

Solvers

The **NX Motion** solver supports the same functionality as the Simcenter Motion Solver, with the exception of the following:

- Tires and roads
- Flexible links
- Co-simulation
- Model definition files
- Adams and RecurDyn results in the Simcenter Results Viewer

When you see a reference to the Simcenter Motion Solver in the documentation, the same reference applies to the NX Motion Solver. With the exceptions listed above, if it is supported in the Simcenter Motion Solver, it is supported in the NX Motion Solver. Likewise, if it is not supported in the Simcenter Motion Solver, it is not supported in the NX Motion solver.

The assembly algorithm in the Simcenter Motion Solver is different from the assembly algorithm in Virtual.Lab. This difference could result in different positioning of the components when you send them to the solver. Therefore, for models that are defined in a non-assembled state and which have drivers, the results of assembly analysis may be different. To resolve this difference, you should introduce enough initial conditions to guide the assembly analysis to the desired assembled solution. You can also modify the model to define it in an assembled configuration.

Models that are defined with redundant constraints and friction elements with non-zero stiction coefficients may cause over-constrained systems that the software may not be able to solve.

**Update Design Position**

This functionality is removed from the Simcenter 12 release.
Chapter 8: Validation

Check-Mate and Requirements Validation

Caveats

Validation rules

Validation rules do not yet recognize unset part attributes.

Using Teamcenter as the issue site for NX Issue Management

When you use NX Issue Management, you can specify Teamcenter as the issue site only when Teamcenter Issue Manager is deployed via Teamcenter Environment Manager at the server side. NX displays an error message if it cannot connect to Teamcenter Issue Manager. For more information, refer to the Teamcenter Environment Manager Help.
Chapter 9: Tooling Design

Press Die Checker

Product Notes

NX Press Die Checker

NX Press Die Checker is designed to validate press dies, specifically in regard to internal collisions. It replaces NX Die Validation. The NX Press Die Checker user interface allows a smooth transition between die modeling and simulation, without a need for conversion steps. It provides fast methods for defining motion components (cams) inside the die, to rapidly calculate collisions. NX Press Die Checker is part of the NX Press product. The NX Press product will be developed in future NX versions, thus enabling a full press line simulation.

Weld Assistant

Documentation notes

Weld Point Wizard

When you create weld points using the Weld Point Wizard, when you set Method to Existing Point, clear the Automatic Update check box to ensure that the newly created linked faces are deleted.
Chapter 10: Data translation
Product Notes

Updates in the default tessUG.config JT configuration file

The doSectionViews configuration option which is used to process non-lightweight PMI section views (also known as heavyweight section views) is removed from the default tessUG.config file shipped with NX11. This option is now renamed as LegacyHeavyweightSectionViews. If your existing NX part or assembly contains section views created using PMI tab→Section View command in Pre-NX11 versions and you want to translate these section views to a JT file, you need to add LegacyHeavyweightSectionViews option in your tessUG.config configuration file and set it to true.

CATIA V5 translator product notes
You can now import CATIA V5-6R2017 SP2 files to NX.

ACIS translator product notes
You can now read and write ACIS version up to R26.

DXF/DWG translator product notes
You can now read and write AutoCAD DXF/DWG version up to 2017.

NX to JT translator product notes
NX to JT translator now supports the IRAY texture material translation to the JT file.

NX ProE translator product notes
You can now import Creo4.0 files to NX.
Caveats

Internationalization caveat
File import or export by the following translators may not work if you set the NX temporary directory UGII_TMP_DIR to a folder containing non-locale characters.

- DXF/DWG
- IGES
- STEP
- 2D Exchange (export only)

NX to JT translator caveats

NX to JT translator caveat for the Windows operating system
NX to JT translator does not support new IRAY+ materials, textures, and lights defined on objects in an NX part. When translator encounters such parts during processing, it writes the base color of the object in the JT file and adds a warning message in the log file.

If you are translating pre-NX11 parts with material, texture, and light applied on it and you want to get the texture or light information into the JT file, We recommend you to invoke NX in Author2 (non-IRAY+) rendering mode and then translate the parts to a JT file. This recommendation is applicable for JT creation from interactive NX session as well as command line application ugtopv. Contact GTAC to get more information on how to invoke NX in Author2 (non-IRAY+) rendering mode.

JT configuration option advancedMaterials in the JT configuration file is not applicable for the new IRAY+ materials, texture, and lights.

By default, NX 11 uses new IRAY+ renderer and the Material, Light and Texture option is not available in the JT Configuration and the Export JT dialog boxes.

Note

If you invoke NX in Author2 (non-IRAY+) rendering mode then these options will be available in the JT Configuration and the Export JT dialog boxes.

NX to JT translator caveat for the Linux operating system
During JT creation on Linux operating system, you may experience issues like freeze of translation process for some parts. This is not a generic issue and only occurs with specific part files. If you encounter any such issue with your part files, please contact GTAC and log an IR.

NX to JT - IRAY texture and material caveats
In some situations, you may find differences between the quality of the texture displayed in NX and that displayed in JT, when you view it in the Teamcenter Visualization.

NX to JT translator - PMI support caveats
- General PMI tables (or tabular notes) - Specialized tables like parts lists, dimension (or tolerance) tables, hole tables, and routing tables are not supported in JT.
• PMI Bolt circle centerline location is not correct in JT.

**DXF/DWG translator caveats**

**DXF/DWG — Dimension export caveats**

These caveats are applicable when you export a file using the 3D option in the AutoCAD DXF/DWG Export Wizard dialog box.

• Dimensions associated with external references are exported as non-associative dimensions to the DXF/DWG file.

• NX Radius dimensions associated with ellipse or spline object are translated as AutoCAD block reference.

• The dimension associated between NX sheet object and View port object may be translated as overridden text of AutoCAD dimension.

• Narrow dimensions are exported as non-associative dimensions to the DXF/DWG file.

• Chamfer and Thickness dimensions are exported as block reference to the DXF/DWG file.

• Angular dimensions created with vector option are exported as block reference to the DXF/DWG file.

• Dimension with fits tolerance having fit tolerance style other than Fit Symbol is exported as block reference in AutoCAD.

• Dimension text location may not match with NX for the dimensions created with oriented text.

• Dimension line breaks and foreshortening symbols are not supported when dimension is exported as group or block.

• If a dimension text is on the extended dimension line, the exported dimension has to be updated to view any foreshortening symbols on it.

**DXF/DWG — MText import caveats**

You cannot import:

• MText paragraph tabs to NX.

• Euro symbol (created using %128 in MText) to NX.

**DXF/DWG — Architecture data import caveats**

• You can not import:
  
  o View dependent data
  
  o Texture data
  
  o Corner windows
  
  o Wall cleanups
o Body modifiers on staircase

• Associativity defined between the architecture objects is not maintained in NX. For example, door on wall will not move along if wall is moved.

DXF/DWG — Solids import caveats

You cannot import:

• Material, color, and transparency applied on solids in the DXF/DWG file.

• Solids data at location outside the NX supported bounding box.

DXF/DWG translator- Image translation Caveats

• When you import DXF/DWG model data to NX drawing view, the translator does not support image translation.

• When you import DXF/DWG file that contains image rotated by angle which is not in a multiple of 90, the image is imported with zero degree rotation.

  Note
  In NX, the images are rotated in steps of 90 degrees only.

• When you import DXF/DWG file with images having other than .jpeg, .tiff, and .png formats to NX, the translator does not support importing of such images.

• Images are not imported if exported as CGM.

• Image translation is not supported if the DXF/DWG file is imported to workpart.

DXF/DWG translator- 3D Workflow caveats

When you export View Breaks using 3D workflow, the translator does not support an export of the following:

• NX Object clipping and view break symbols.

• Geometry clipped inside a view boundary.

• A section line arrow in Break view.

Dimension export using 3D workflow

• When a dimension is exported as a block reference, the foreshortening symbol is not supported.

• 3D workflow does not support the inclusion of before/after appended text in the export of the inspection dimension. It always includes all the appended text in the frame.

• The translator does not support a tolerance separator in the output DXF/DWG file.

Text export using 3D workflow
• When you export text as lines using 3D workflow, the translator ignores the text symbol aspect ratio.

DXF/DWG translator- Associative dims to polyline and block caveats
You cannot import dimension as real associative in following scenarios:
• Blocks are imported as custom symbols or as a part and if dimensions are associated with block reference in the DXF/DWG file.
• Dimensions are associated to 2D and 3D polyline.
• Dimensions that have following Object snap points:
  o Tangent
  o Perpendicular
  o Nearest
  o Apparent Intersection
  o Parallel
  o Intersection
• Dimensions are associated to arc segment of the polyline.

DXF/DWG translator- Support for drafting objects caveats
You can not export:
• Drawings created in the Layout application using the 2D option.
• Custom symbols used in a PMI table.
• Section views.

2D Exchange caveats
• Object attributes with title longer than 50 characters or string value longer than 132 characters are not exported to 2D parts.

2D Exchange – Dimension export caveats
These caveats are applicable for both, when you export a file using the NX Part file option in the 2D Exchange Options dialog box or when you export a file using the 2D option in the AutoCAD DXF/DWG Export Wizard dialog box.

Following dimensions are exported with the Override Dimension Text:
• Feature Parameter Dimensions
• True Length Dimensions
• Dimensions in scaled view and output set to Modeling (applies only when you export a file using the NX Part file option in the 2D Exchange Options dialog box)
• Dimensions associated to:
  o Drafting Intersection point
  o Offset center point
  o Section line (in scaled view)
• The dimensions where associated object type changes in the flattened part. For example, circle projected as line.

Following Data will be exported as grouped geometry in the 2D part file and as a block in the DXF or DWG file.
• Linear and Radial callouts
• Retained dimensions
• Component level dimensions and PMI dimensions
• Inherited ordinate PMI dimensions
• Dual dimension in scaled views and output set to **Modeling**.
• Dimension with hole and shaft tolerance in scaled views and output set to **Modeling**.
• Dimensions associated with:
  o Blanked objects
  o 3D and Symmetric centerlines
  o Faces
  o Two object intersection (applies to ordinate dimension only)
  o Target Points
• Dimension created in plane other than view plane.
• PMI Partial Bolt Circle centerline.

**2D Exchange translator- Image translation caveats**
• 2D Exchange Translator does not translate image, if image is not projected on 2D. This happens when image is in XY plane and trimetric view is exported.
• 2D Exchange Translator supports translation of images only if input is being exported to Part File and not to IGES).

**2D Exchange translator- Dimension export caveats**
• When Dimension and a Leader are associated with the symmetrical centerline, the translator exports them as a grouped geometry.
• When a radial dimension is associated with a break view geometry, the translator exports it as a group geometry.

• When a perpendicular and angular dimension is associated with a break view section line, translator exports them as a group geometry.

**2D Exchange translator - Foreshortening Symbol export caveats**

A translator does not support export of foreshortening symbol when dimension is exported as a group in a 2D part.

**2D Exchange translator – Leader caveats**

A leader with an extension line is converted as a grouped geometry when it is associated with a spline in a 2D part.

**2D Exchange translator – Weld symbol caveats**

When you export a weld symbol containing arcs, the translator exports it as a grouped geometry.

**2D Exchange translator – Support for drafting objects caveats**

You can not export:

• Drawings created in the Layout application

• Custom symbols used in a PMI table.

• Section view while exporting Model views.

**DXF/DWG and 2D Exchange - PSM body support project caveats**

• If you export convergent bodies as polyline mesh, it exports only edges.

• Colors are not honored when you import 3D faces as convergent bodies or JT facets.

• Colors applied to face of convergent body is not honored on export.

• You cannot export model views with convergent bodies with 2D Exchange (or using 2D option on DXF/DWG export dialog box).

**STEP translator caveats**

• When you export or save NX data to a .stpx file, STEP translator does not export nested external references.

**CATIA V5 translator caveats**

• When you use the NX Data Exchange external interface to export an assembly on Linux 64 or Mac operating system, the output file field may indicate an extension of .CATPart, whereas the translator will accurately produce an output file with the expected .CATProduct extension.

• The translator exports NX files to CATIAV5 R14 files.

• You cannot import CATIA V5 R7 and earlier version of files.

• You cannot translate standard and user defined attributes.
• Color is supported on a per face basis.

• You can only import CATIA V5 “Lines and Curves” into NX using default “Linetype” and “Thickness” values.

• You cannot export NX parts with file name containing international characters.

• The CATIAV5 translator does not keep a log of failed export of password protected data during translation.

**Caveat for all translators**

The password protected parts or assembly components are not exported to other file formats.
Chapter 11: Mechatronics Concept Designer
Product Notes

PLCOpen XML export for STEP 7

Mechatronics Concept Designer can export the sequence of operation in the standardized XML format PLCOpen XML. PLCOpen XML can be imported into STEP 7 5.5 SP 2 Hotfix 4 and above. If you need to update your current STEP 7 installation you can find information about the latest service packs and hotfixes at the following:

English:
https://support.industry.siemens.com/cs/products?dtp=Download&mfn=ps&pnid=14342&lc=en-WW
Chapter 12: Programming Tools

The Release Notes for Programming Tools are available only with the installed NX Help documentation. After you install the documentation, you can access the information from any of the following locations.

• From the Start menu on your system, choose:
  o All Programs→Siemens NX 12.0→Documentation→NX Release Notes.
  o All Programs→Siemens NX 12.0→Release Information→Release Notes.

• Within NX, choose:
  o File tab→Help→Release Notes.
  o Menu→Help→Release Notes.
Siemens Industry Software

Headquarters
Granite Park One
5800 Granite Parkway
Suite 600
Plano, TX 75024
USA
+1 972 987 3000

Americas
Granite Park One
5800 Granite Parkway
Suite 600
Plano, TX 75024
USA
+1 314 264 8499

Europe
Stephenson House
Sir William Siemens Square
Frimley, Camberley
Surrey, GU16 8QD
+44 (0) 1276 413200

Asia-Pacific
Suites 4301-4302, 43/F
AIA Kowloon Tower, Landmark East
100 How Ming Street
Kwun Tong, Kowloon
Hong Kong
+852 2230 3308

About Siemens PLM Software

Siemens PLM Software, a business unit of the Siemens Industry Automation Division, is a leading global provider of product lifecycle management (PLM) software and services with 7 million licensed seats and 71,000 customers worldwide. Headquartered in Plano, Texas, Siemens PLM Software works collaboratively with companies to deliver open solutions that help them turn more ideas into successful products. For more information on Siemens PLM Software products and services, visit www.siemens.com/plm.